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PREFACE

Disclaimer:
Information contained herein is for informational and educational purposes solely and is not an

endorsement of any product contained in these materials. Any copyrighted materials, referred to herein,
are subject to the protections of copyright law.
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1.0 Introduction

The NRC has prepared this “Desk Reference Guide for PDF Document Generation”
to help its customers and other Federal agencies generate PDF (Portable File
Format) files that comply with NRC’s “Guidance for Submission of Electronic Docket
Materials under 10 CFR Part 2, Subpart J” (http://www.nrc.gov/about-
nrc/regulatory/adjudicatory/ehd/ml041560341.pdf) and the specifications in Sections
2.1, 2.5, 2.6, and 2.9 of NRC’s “Appendix A: Guidance for Electronic Submissions to
the Commission” (http://www.nrc.gov/site-help/e-submittals/quid-elec-
submission.pdf). This guide gives the required custom settings for generating PDF
files from commonly used applications such as MS-Word and MS-Excel, and Corel
WordPerfect and Presentation. It does not address special applications to include
scanning software and graphics enhancement software such as Adobe Photoshop
and Corel Draw. It does not address hardware configurations for scanning text or
graphic images to generate a PDF file. This document was created and tested
using Adobe Acrobat 6.0 and 7.0 Professional, Microsoft Office Suite XP and 2003,
and Corel WordPerfect Office 2002. Please contact the manufacturers for
instructions on software or hardware that is not mentioned in this desk reference
guide.

2.0 Support and Contact Information
u Feedback

We want to hear from you. If you do not find the information you need in
this guide or wish to send comments, find broken link(s) on our Web site,
or have problems finding information on our Web site, please contact the
NRC Web Team by completing the form at
http://www.nrc.gov/site-help/feedback.html.

n HLW (High-Level Waste) Technical support

NRC will continue to assist HLW submitters with any technical questions
or concerns during the pre-licensing, pre-hearing, and hearing phases. If
you have technical problems in complying with “Guidance for Submission
of Electronic Docket Materials under 10 CFR Part 2, Subpart J”, contact
the help desk. The support hours are as follows:

Pre-licensing phase: 8:30 A.M. — 4:15 P.M. eastern time, Monday —
Friday (except holidays). Contact the PDR (Public Document Room) at
1-800-397-4209.

Pre-hearing phase: 24 hours, Monday — Friday (except holidays).
Contact information will be provided.

Hearing phase: 24 hours, Sunday — Saturday (except holidays). Contact
information will be provided.



u Non-HLW Technical support

If you have technical problems in complying with the “E-Rule” guidance,
such as converting documents to PDF files, setting software
configurations, fixing problems with deficient submittals, or any questions
regarding materials discussed in this guide please contact the PDR at
1-800-397-4209 or at http://www.nrc.gov/reading-rm/contact-pdr.html,
Monday — Friday, 8:30 A.M. — 4:15 P.M. eastern time (except holidays).

3.0 System Requirements and Recommendations
3.1 Adobe Acrobat 5.0 requirements

Windows
* Intel® Pentium® processor
¢ Microsoft® Windows 95 OS R 2.0, Windows 98 SE, Windows Millennium Edition,
Windows NT® 4.0 with Service Pack 5, Windows 2000, or Windows XP
64MB of RAM
24MB of available hard disk space
1,024x768 screen resolution
CD-ROM drive
scanner (optional)

Macintosh

*  PowerPC® processor
Mac OS 8.6, 9.0.4, 9.1, or Mac OS X
64MB of RAM
24MB of available hard disk space
1,024x768 screen resolution
CD-ROM drive
scanner (optional)

3.2 Adobe Acrobat 6.0 Professional requirements

Windows
* Intel® Pentium® processor
*  Microsoft® Windows 98 Second Edition, Windows Millennium Edition,
Windows NT® 4.0 with Service Pack 6, Windows 2000 with Service Pack 2, on
Windows XP Professional or Home Edition
32MB of RAM (64MB recommended)
60MB of available hard disk space
Microsoft Internet Explorer 5.01, 5.5, 6.0, or 6.1
1,024x768 screen resolution
CD-ROM drive
scanner (optional)



Macintosh

PowerPC® G3 processor

Mac OS X v.10.2.2-10.3

32MB of RAM (64MB recommended)

30MB of available hard disk space (130MB recommended)
HFS formatted hard drive

1,024x768 screen resolution

CD-ROM drive

scanner (optional)

100MB of available hard drive space

3.3 Adobe Acrobat 7.0 Professional requirements

Windows

Intel® Pentium® processor

Microsoft® Windows 2000 SP2, Windows XP Professional, or Windows XP
Home Edition

Microsoft Internet Explorer 5.5, 6.0, or 6.1

128MB of RAM (256MB recommended)

460MB of available hard disk space and cache for optional installation files
(recommended), requires an additional 300MB of available hard disk space
1,024x768 screen resolution

CD-ROM drive

scanner (optional)

Internet or phone connection required for product activation

Macintosh

PowerPC® G3,G4, or G5 processor

Mac OS X v.10.2.8, or 10.3

128MB of RAM (256MB recommended)

495MB of available hard disk space

1,024x768 screen resolution

CD-ROM drive

scanner (optional)

Internet or phone connection required for product activation



4.0 Software Setup and Configuration
4.1 Setting up and configuring Adobe Acrobat Distiller/PDFMaker and setting

preferences
411 m Adobe Acrobat 5.0

Note: You can download and install a Distiller Job Options file (profile) created by NRC
by following instructions in question 7 of the FAQs section.

Launch Adobe Acrobat Distiller by clicking on Tools from the main menu and select
Distiller (Tools => Distiller).

B8 Adobe Acrobat

[ O[]
File Edit Document | Tools Yiew Window Help
@B S G Comes

- IR |

»
[Blow =6 | camswaws o [2R [T @07 Z-E &
»

=k Self-Sign Security
[Bs s =

Web Capture

accessibility Checker. .

The Acrobat Distiller window pops up with eBook as the default for Job Options.

Acrobat Distiller _ (O] x|
File Settings Help

Job Options: Sl

Compatibilty:  Acrobat 4.0 (PDF 1.3)
rInfo

Pause

File: none 4|
Size: |

5 : LCancel Job

r Progress
Status:  Ready

Acrobat Distiller 5.0 =]
Started: Tuesday, June 28, 2005 at 3:53 PM

Adobe PostScript software version: 3011.104




Change the settings and create a new profile by going to the pulldown menu and
selecting Settings = Job Options.

E3| Acrobat Distiller M=l &3
File | Settings Help

Font Locations...  Ctrl+.
Watched Folders... Ctrl+F

il Job Options... Ctrl+]
Security... Ctrl+5 Pause |
Size:
5 |zel Eaneel)ob |
ource:
— Progress
Status: Ready

Acrobat Distiller 5.0 =]
Started: Tuesday, June 28, 2006 at 3:53 PM
Adobe PostScript software version: 3011.104

=

The default eBook - Job Options window pops up. Under the General tab, change
the following settings.

*  From the dropdown menu, set Compatibility to Acrobat 5.0 (PDF 1.4).
» Verify that Optimize for Fast Web View is checked.

* Uncheck Auto-Rotate Pages.

» Verify that All is selected for Page Range.

* Keep Left as the Binding default.

+ Set Resolution to 300 dpi (dots per inch).

eBook - Job Options [ |

General |Compression I Forts I Color I Advanced I

r— File Options
Save As...
Compatibilty:  [Acrobat 5.0 (PDF 1.4) =l —l
V¥ Optimize for Fast Web View ﬂl

™ Embed Thumbnails
[ Auto-Rotate Pages:
Page Range: % Al

“ Erom:l To: I
Binding: ILeﬂ 'l
Besolution: |3DD dpi

r— Default Page Size

Width: IE.S Units: Ilnches 'l
Height: I‘I‘I.D

Collectively by File ~




Select the Compression tab and change the fields for all sections as follows:

+ Color Images
Uncheck Bicubic Downsampling to
for images above: 300
Compression: ZIP
Quality: 8-bit

* Grayscale Images
Uncheck Bicubic Downsampling to
for images above: 300
Compression: ZIP
Quality: 8-bit

*  Monochrome Images
Uncheck Bicubic Downsampling to
for images above: 450 dpi
Compression: CCITT Group 4
Uncheck Compress Text and Line Art

eBook - Job Options E3 |

General Compression |Furrts I Colar I Mvancedl

—Color Images
|_ IEi-:uI:-i-: Downsampling to j |1'5: dpi e |
forimages above: |3|}[:u dpi
Cancel |
W Compression; IZIF‘ j
Quality: Ig,b-,t j
—iGrayscale Images
r IEi-:uI:-i-: Downsampling to j |1E: dpi
for images above: |3DD dpi
I¥ Compression: |z||:~ j
Qluality: Ig.t,-,t j
— Monochrome Images
|_ IEi-:uI:-i-: Downsampling to j I?CC dpi
forimages above: |450 dpi
[V Compression: |CCITT Group 4 |
[~ Anti-Alias to gray: |4 bit -
[~ Compress Text and Line Art;




Click on the Fonts tab and—
* Verify that the Embed All Fonts box is checked.

+ Verify that Subset embedded fonts when percent of characters used is less
than is checked and set at 100%.

* Keep Warn and Continue as the default for When Embedding Fails.

* In the Embedding section, select C:\WINDOWS\Fonts\ from the dropdown menu
and remove everything in Never Embed (if there is anything) by selecting
everything in the Never Embed field and clicking on the Remove button.

eBook - Job Options
General I Compression  Fonts |Culur I Advanced I

¥ Embed All Forts

Subset embedded fonts when percent . Save A=
4 of characters used is less than: I-I 00 | %

Cancel

Elelk

When Embedding Eails: I‘."'.n'am and Continue j
— Embedding

| WINDOWS Forts\ =l Mways Embed:

LibBT-Regular ﬂ ﬂ
AoencyFB-Bold

AgencyFB-Reg ﬂ

Albertus-ExtraBold

Abertus-Medium

AbertusMT =
AlbertusMT-ltalic
4 bertusMT-Light Mever Embed:

Aldined01ET-BoldA ;I
Aldine401BT-BoldktalicA
Aldined1BT-kalicA
Aldine401BT-RomanA ﬂ
Adine 721BT-Bald

4ldine 721 BT-Boldhalic j

Adine 721 BT-talic
Add|Hame... | Bemove I

7/dine 721BT-Light d|




Click on the Color tab.
In the Adobe Color Settings section—
* Make sure the Setting File is set to None.

+ Change Color Management Policies to Tag Everything for Color Management.

* Keep Intent set to Default.
+ For the Working Space subsection—
» Set Gray to None.

» Keep RGB set to sSRGB IEC61966-2.1.
» Keep CMYK set to U.S. Web Coated (SWOP) v2.

In the Device-Dependent Data section—
* Click on Preserve Under Color Removal and Black Generation Settings and
make sure it is checked.

« Set Transfer Functions to Preserve.

eBook - Job Options

General I Compression | Forts  Color |M\ranced |

— Adobe Color Settings K

Settings File: I Mone j Save As..

ElEl

Cancel

— Color Management Policies

ITag Eventhing for Calor Management j

Intent: | Defaut |

—Working Spaces

Gray: INDne -
RGE: [sRGE IEC61966-2.1 =
CMYK: [U.5. Web Coated (SWOF) v2 -

— Device-Dependent Data
[~ Preserve Overprint Settings:
[ Preserve Under Color Removal and Black Generation Settings

IPrE:sen-'e vl Transfer Functions

[~ Preserve Halftone Information




Click on the Advanced tab and make sure the following items in the Options
section are checked:

* Allow PostScript file to Override Job Options.
* Preserve Level 2 copypage Semantics.

+ Save Portable Job Ticket inside PDF file.

* Convert gradients to smooth shades.

The following items should be checked and enabled in the Document Structuring
Conventions (DSC) section:

*  Process DSC comments.

* Resize Page and Center Artwork for EPS Files.
* Preserve EPS Information from DSC.

* Preserve OPlI Comments.

*  Preserve Document Information from DSC.

T |
General I Compression I Forts I Color  Advanced |
—Optiong K
[~ Use Prologue ps and Epilogue ps
W Alow PostScript file to Ovemide Job Options

¥ Preserve Level 2 copypage Semantics Cancel
¥ Save Portable Job Ticket inside PDF file
[T lustrator Overprint Mode

W Convert gradients to smooth shades

I~ ASCIl Format

Save As .

EEk

— Document Structuring Conventions (D5C)
¥ Process DSC Comments
[T Log DSC Wamings
¥ Resize Page and Center Atwork for EPS Files
¥ Preserve EPS Information from DSC
W ‘Preserve OF| Commentsi
W Preserve Document Information from DSC

Click on - |in the upper right corner of the window to save the changes.




In the File Name field, enter NRC-10CFR1.joboptions as a new profile name (or
whatever name you want to call it). Clickon| && |. Then & |.

Save Job Options As K |

Save in: I ) Settings j - cF E2-

¥ =5ook. joboptions:
J Press.joboptions
J Frint.joboptions

Screen.joboptions

File name: INHC-‘I ICFR1 joboptions Save
Save as type: IJI:ItI Optionz Files (* joboptions) j Cancel

The Acrobat Distiller window now pops up. Verify that Job Options is set to your
newly created profile (for example, “NRC-10CFR1"), as in the screen below.

E3 | Acrobat Distiller [_ O] x|
File Settings Help

Job Options:  [{R]sTes]rey
Compatibility:  Acrobat 5.0 (PDF 1.4)
— Irfo

Pause
File: none =

Size:
Source:

i

EancelJiok

— Progress

Status: Ready

i

Acrobat Distiller 5.0
Started: Tuesday, June 28, 2005 at 3:53 PM

Adobe PostScript software version: 30711.104




Select File = Exit or click on x| to close Acrobat Distiller.

E3| Acrobat Distiller
Fle Settings Help
Open... Ctrl+0

=] E3

Preferences... Ctrl+ (PDF 1.4)

Cirl+Q
Pause |
S SIIEE LaneelJob
ource: ===
— Progress
Status: Ready
I
Acrobat Distiller 5.0 ]
Started: Tuesday, June 28, 2005 at 3:53 PM
Adobe PostScript software version: 3011.7104




4.1.2 m Adobe Acrobat 6.0 Professional

Note: You can download and install a Distiller Job Options file (profile) created by NRC
by following instructions in question 7 of the FAQs section.

Launch Adobe Acrobat Distiller by clicking on Windows Start = Programs =>
Adobe Acrobat Distiller 6.0 or while in Adobe Acrobat Professional application,
select Advanced => Acrobat Distiller.

£ Adobe Acrobat Professional
File Edit VYiew Document Tools BEGFERE=GE Window Help
LY = 1]

Q-0 00 e (e
= ] § Batch Processing...

x W7 Y M- cewes.

eBook Web Services 4

JavaScript 4
Links 4
Manage Digital IDs 4

Web Capture 4

Use Local Fonts Shift+Ctr+Y

Proaf Setup 4

Transparency Flattener Preview. ..

The Acrobat Distiller window pops up.

& Acrobat Distiller

Eile Settings Help
Adobe PDF Settings
Compatibiity:  Acrobat 5.0 (PDF 1.4)
Use these settings to create PDF documents suitable for
reliable viewing and printing of business documents. The
PDF documents can be opened with Acrobat and Reader
5.0and later.
Current File Information
File: none
Size: Cancel Job
Source:
Progress
Status: Ready
/Courier-BoldObligue ~|
/Courier-Bold |
/Courier
/Courier-Oblique ]
]|




Change the settings by selecting Settings => Edit Adobe PDF Settings.

g Acrobat Distiller

Font Locations...
Watched Folders. ..

Edit Adobe PDF Settings...
2 Add Adobe PDF Settings...
G REemowve Adobe PDF Settings...
Security...

Curmrert File Information
File: none

Size:
Source:

Progress
Status:

ACourier-BoldOblique
ACourier-Bold
ACourier
ACourer{blique




Now the Standard - Adobe PDF Settings window pops up. Under the default
General tab, make the following settings as shown below.

In the Description section, enter: Use these settings to create Adobe PDF
documents suitable for compliance with 10CFR1, Appendix A. Created PDF

documents can be opened with Adobe Reader 5.0 and later.

From the dropdown menu, set Compatibility to Acrobat 5.0 (PDF 1.4).

Keep Tags only as the Object Level Compression default.
Set Auto-Rotate Pages to Off.

Keep Left as the Binding default.

Set Resolution to 300 dpi (dots per inch).

Verify that All Pages is selected.

Verify that Optimize for fast web view is checked.

Standard - Adobe PDF Settings

General ||mages Fonts || Color || Advanced | PDF/X

Description

|Jse these settings to create Adobe PDF documents sutable for compliance with
10CFR1, Appendix A. Created POF documents can be opened with Acrobat and
Reader 5.0 and later]

File Cptions
Compatibility: |Acn:|bat 5.0(PDF 1.4) - |
Object Level Compression: |Tags only L |
Auto-Fotate Pages: |OH w |
Binding: ||_eﬂ w |
Resolution: dots perinch
(%) All Pages

() Pages From: I:I Ta: l:l

] Embed thumbnails
Optimize for fast web view

Default Fage Size
Width: |8.5 Units: | Inches w

Height:

Saveﬂs...] [ oK ] l Cancel ] Help




Click on the Images tab and change the fields as follows:

+ Color Images
Downsample: Off
Compression: ZIP
300 ppi

* Grayscale Images
Downsample: Off
Compression: ZIP
300 ppi

*  Monochrome Images
Downsample: Off
Compression: CCITT Group 4
Anti-alias to gray: Off
450 ppi

Standard - Adobe PDF Settings

General | Images | Forts || Color | Advanced | PDF/X|

Color Images
Downgample: |Oﬁ w | |3{H} pixels perinch
Compression: |Z|F' v|
Grayscale Images
Downsample: |0f'f b | |3'|]'|]' pixels perinch
Compression: |ZIF' v|
Manochrome Images
Downsample: |0ﬁ w | |45ﬂ pixels perinch
Compression: | SERRRC T M - |
Anti-glias to gray:
savess. | [ ok | | Cancel | [ Hebp




Click on the Fonts tab and—
+ Verify that the Embed all fonts box is checked.

» Verify that Subset embedded fonts when percent of characters used is less
than is checked and set at 100%.

* Keep Warn and continue as the default for When embedding fails.

* In the Embedding section, verify that Font Source is set to C:\WINDOWS\Fonts\
and remove everything in Never Embed (if there is anything) by selecting
everything in the Never Embed field and clicking on the Remove button.

Standard - Adobe PDF Settings

General Images| Forts |C|:|I|:|r Advanced | PDF/X

Embed al forts

Subset embedded fontz when percent of characters used is less than: 4

When embedding fails: | Wam and cortinue w | %

Embedding
Fort Source:
CAWINDOWS Fonts, w

AdlibB T-Reaqular S
Aldined01BT-BoldA
Aldine401BT-BoldtalicA
Aldined01BT-talicA
Aldine401BT-RomanA
Aldine721B8T-Bold
Aldine721BT-Bolditalic !
Aldine 721B T-talic Neyer Embed:
Aldine 721BT-Light
Aldine721BT-Light talic
Aldine721BT-Roman

Alefbet Momal

T MexeiCopperplate TC-Normal
AlgerianBasD

AlgeranD

AllegroBT-Regular %

Always Embed:

[ ok ] [ cance | Help




Click on the Color tab.
In the Adobe Color Settings section—

* Make sure Settings File is set to None.

+ Change Color Management Policies to Tag Everything for Color Management.

* Keep Intent set to Default.
* For the Working Spaces subsection—
» Set Gray to None.

» Keep RGB set to sSRGB IEC61966-2.1.
» Keep CMYK set to U.S Web Coated (SWOP) v2.

In the Device-Dependent Data section—

* Click on Preserve under color removal and black generation option
and make sure it is checked.

« Set When transfer functions are found to Preserve.

Standard - Adobe PDF Settings

General | Images || Forts |C0|0F |Advanu:ed PDF/X

Adobe Color Settings
Settings File: | MNaone w |

Color Management Policies

|Tag Everything for Color Management w |

jnterrt:| Default w |

Working Spaces

Qla*,':l Mone w |
RGB: | sRGB IECE15966-2 1 v|
CMIK:l .5 Web Coated (SWOP) v2 w |

Device-Dependent Data

Preserve under calor removal and black generation

When transfer functions are found: w

[] Preserve halftone information

[Sa\reﬂs... ] [ 0K l [ Cancel ] [ Help




Click on the Advanced tab and make sure the following items in the Options
section are checked:

* Allow PostScript file to override Adobe PDF settings.
* Convert gradients to smooth shades.

* Preserve Level 2 copypage semantics.

* Preserve overprint settings.

* Overprinting default is nonzero overprinting.

+ Save Adobe PDF settings inside PDF file.

+ Save original JPEG images in PDF if possible.

+ Save Portable Job Ticket inside PDF file.

The following items should be checked and enabled in the Document Structuring
Conventions section:

* Process DSC comments.

* Preserve EPS information from DSC.

* Preserve OPl comments.

* Preserve document information from DSC.

* Resize page and center artwork for EPS files.

Standard - Adobe PDF Settings

General | Images | Forts || Color | Advanced | PDF/X
COptions
Allow PostScript file to ovemide Adobe PDF settings
[] Mllow PostScript ¥Objects
Convert gradients to smooth shades
[] Create Job Defintion Format {JDF) file
Preserve Level 2 copypage semantics
Preserve overprint settings
COwerprinting default is nonzeno overprinting
Save Adobe PDF settings inside PDF file
Save onginal JPEG images in PDF if possible
Save Portable Job Ticket inside PDF file
[] Use Prologue ps and Epilogue ps

Document Structuring Conventions (DSC)
Process DSC comments
(] Log DSC wamings
Preserve EPS information from DSC
[¥]Freserve OF| comments:
Preserve document information from DSC
Besize page and center artwork for EFS files

[ Save fAs.. ] I 0K ] [ Cancel ] [ Help ]




Leave everything as is under the PDF/X tab.

Standard - Adobe PDF Settings

| General || Images || Forts || Caolar || Advanced | PDF/X

PDF/ ¥ Reporting and Compliance
CIFDFAia [IPOF/X3

When not compliant:

i Meither

TrimBox nor ArtBax are Specified

Right: | |

e ]
if EleedBox is Mot Specified
Right: | | Top: | | Bottom: I:I

Default Values f Mot Specified in the Document
Outputintert Profile Name:

QutputCondition: |

ReqistryMame {URL): |

Trapped:

[ savens. | [ ok |

Click on 5. | in the bottom left corner of the window to save the changes.

In the File Name field, enter NRC-10CFR1.joboptions as a new
. Then & |.

whatever name you want to call it). Click on | e

Save Adobe PDF Settings As

rofile name (or

Savein: ‘ (2 Settings - ‘ e 5 s
Y .gHigh Quality. joboptions
4 :3 NRC-10CFR. joboptions
My Recent ’PDF.\ ia.joboptions
Documents | | 3 POFX3.joboptions
= .gPress Quality.joboptions
@ ’Sma\lest File Size.joboptions
Deskiop gsbndard‘jubuptuns
Iy Documents
My Computer
. File name: ‘NHCJ OCFR1|joboptions hd | [ Save I
NRC Network | Saveastype: | Adobe PDF Settings Fies [*joboptions) v| [ cancal |




The Acrobat Distiller window now pops up. Verify that the Default Settings is set
to your newly created profile (for this example, “NRC-10CFR1"), as in the screen

below.

& Acrobat Distiller [Z| [E| E'

File Settings Help
Adobe PDOF Settings

Defauit Settings: | [{ERITERE v|

Compatibility: Acrobat 5.0 (FDF 1.4)
@ |se these settings to create Adobe POF documents sutable

for compliance with 10CFR1, Appendix A. Created POF
documents can be opened with Acrobat and Reader 5.0 and

later.
Cument File Information
Fle: none
Size: Cancel Jok
Source:
Progress
Status: Ready

Acrobat Distiller 6.0
Started: Tuesday, August 02, 2005 at 10:02 AM

Adobe PostScript software version: 3015.102

Select File =>Exit or click on E] to close Acrobat Distiller.

& Acrobat Distiller

5=8 Settings Help
Open... Cirl+0

Preferences... Cirl+K -10CFR1 w |
= 20 FOF 14
wermrgewe-oieate Adobe PDF documents suitable

1 )for compliance with 10CFR1, Appendix A. Created PDF
documents can be opened with Acrobat and Reader 5.0 and

later.
Current E:::Ili?,:neatlon
Size: Cancel Job
Source: -
Progress
Status: Ready

Acrobat Distiler 6.0
Started: Tuesday. August 02, 2005 at 10:02 AM

Adobe PostScrpt software version: 3015.102




It is important to set the preferences in Adobe Acrobat so that you can convert
different types of documents to PDF while in Adobe Acrobat.

From the main menu click on Edit => Preferences to set the preferences.

Adobe A bat P L]
File: View Document Tools Advanced Window Help
- [ unce Ctrl+Z Ecmmr - ) Review & Comment ~ () secure - & sign - [§] -

| ¥ Redo Shift+Ctrl+2

=]

= o
mow

(=]

Check Spelling

Add Bookmark

Search Results

Preferences...




In the Preferences window, select the Convert To PDF option in the subwindow.
You will see a list of applications in the Convert to PDF subwindow. One of these
applications may be the application used to create your document. The screen
below gives configuration instructions for MS-Office and Project documents and for
TIFF images. Select and change the configurations for your application.

Microsoft Office

-« Select Microsoft Office and click on % .

Preferences
W Converting To PDF
Batch Processing
Catalog QEEDCAD Click Edit Settings to view or edit settings for this file type.
Color Management
. Compuserve GIF
Commenting
HTML
Convert From PDF
Convert To PDF JPEG
Digital Signatures JPEG 2000
Farms Microsoft Office
Microsoft Project
Full Screen ! o
Microsoft Visio
General Pox
Identity ’
Internet PNG
; PostScript/EPS
JavaScript
o Text
Multimedia TF
Page Display
Reading
Reviewing
Search
Smoothing
Speliing
Startup
TouchUp
Trust Manager
Units & Guides
Updates

Web Capture

)

oK ] [ Cancel

In the Adobe PDF Settings for supported documents window, click on the
dropdown menu and select the newly created profile (for this example, “NRC-
10CFR1"). Click on Convert entire Excel workbook to ensure that the
conversion of the whole Excel workbook is supported. Then click on ®




Adobe PDF Settings for supported documents

Adobe PDF Settings: |NRC-1EICFR v| ’ Edit...

Add bookmarks and links to Adobe POF file
Convert entire Excel workbook

Adobe PDF Security: |N|:|ne w | Edit

Enable accessibility & reflow (Microsaft Office 2000,%F only)

[ oK M ’ Cancel ]

Microsoft Project

. Select Microsoft Project and click on _Eftstings.. | .

Preferences

Accessibility Conwerting To PDF

Batch Processing

Catalog S;ECAD Click Edit Settings to view or edit settings for this file type.

Color Management

. Compuserve GIF

Commenting
HTML

Convert From PDF

Convert To PDF JPEG

Digital Signatures JPEG2000

Farms Microsoft Office
Microsoft Project

Full Screen - -
Microsoft Visio

General PCX

Identity y

Internet PNG

) PostScript/EPS
JavaScript
R i Text

Multimedia -

Page Display

Reading

Reviewing

Search

Smoothing Edit Settings..

Spelling k

Startup

TouchUp

Trust Manager

Units & Guides

Web Capture

OK

] ’ Cancel

x)




In the Adobe PDF Settings window, verify that the newly created profile (for
this example, “NRC-10CFR1") is selected. Then clickon _« |.

Adobe PDF Settings

Adobe PDF Settings:

MNRC-10CFR

Edit... |

Adobe POF Security:  |Mone

Cancel ]

TIFF

. Select TIFF then click on &t |

Preferences

Accessibility
Batch Processing
Catalog

Color Management
Commenting
Convert From PDF
Digital Signatures
Forms

Full Screen
General

Identity

Internet
JavaScript
Multimedia

Page Display
Reading
Reviewing
Search
Smoothing
Spelling

Startup

TouchUp

Trust Manager
Units & Guides
Web Capture

Converting To PDF

AutoCAD

EMP
Compuserve GIF
HTML

JPEG

JPEG2000
Microsoft Office
Microsoft Project
Microsoft Visio
PCX

PMG
PostScript/EPS
Text

Monochrome Compression; CCITT G4

Grayscake Compression: JPEG (Guality : Medium)

Color Compression: JPEG (Quality @ Madium)

RGE Policy: Preserve embedded profiles

CMYK Policy: OF

Gray Policy: Off

(ither Policy: Preserve embedded profiles

OK. ] ’ Cancel




The Adobe PDF Settings window appears with the default settings.

Adobe PDF Settings

Compression

Monochrome: | ([ssgpieg]
Grayscale: |JPEG (Quality : Medium) v |
Color: |JF‘EG {Quality : Medium) v |

Color Management

RGE: |F‘reserve embedded profiles  w |

cMyK: | Off v/

Grayscale: |Off A |

Other: |Preserve embedded profiles - |

[ OK l [ Cancel ]

* Change the settings in the Compression section as follows:

» Set Grayscale to ZIP.
» Set Color to ZIP.
» Leave the rest as is.

Adobe PDF Settings

Compression
Monochrome: | CCITT G4 v
Grayscale: | zIP v|
Color: | ZIP v|

Color Management

RGE: F're:;erve embedded profiles

cmvk: | off v
Grayscale: |01"f v|
Other: |Preserveembeddedproﬁles v| Q
[ Ok, ] [ Cancel ]

e Clickon__&® |.

Click on Ll again in the Preferences window.



4.1.3 m Adobe Acrobat 7.0 Professional

Note: You can download and install a Distiller Job Options file (profile) created by NRC
by following instructions in question 7 of the FAQs section.

Launch Adobe Acrobat Distiller by clicking on Windows Start ©> Programs =>
Adobe Acrobat Distiller 7.0 or while in Adobe Acrobat Professional, select
Advanced => Acrobat Distiller.

File Edit View Document Comments Tools | Advanced Window Help

DA RE & @ =

Q?'} ]}SE'ECT h‘] @\v Ll _:J Batch Processing...
Digital Editions

Export All Images...
Forms.

JavaScript

Links

Migrate Comments. ..
INumber Pages...
POF Optimizer. ..
Security Settings...
Trusted Identities. ..
Web Capture

Use Local Fonts Shift+Ctrl+Y

Gverprint Preview Shift+Ctr +7
Ea. GuiputPreview...
(B prefiight... Shift+Ctrl+%

The Acrobat Distiller window pops up.

P2 Acrobat Distiller [_[O]
fle Settings Help
~ Adobe PDF Settings
Default Setings:
Compatibility: Acrobat 5.0 (PDF 1.4)

Use these settings to create Adobe PDF documents suitable for reliable
Q wiewing and printing of business documents. Created PDF documents can
be opened with Acrobat and Adobe Reader 5.0 and later.

Status: Ready
PDF File Size Time | PS File Size PDF Fold
1] i ol
Acrobat Distller 7.0 =

Started: Thursday. April 14, 2005 at 10:42:50
Adobe PostScript software version: 3016.102




Change the settings by going to the pulldown menu and selecting Settings => Edit
Adobe PDF Settings.

File | Settings Help
—p;  FontLlocations... Ctrl+ I
Watched Folders... Ctrl+F

Edit Adobe POF Settings...

Add Adobe POF Settings... Cirl+5hift+E suitable for reliable
! Remove Adobe POF Settings... Cirl+R PDF documents can
§Emrit5-'. . Ctr|+5 |EtEf
~ Progress
Status: Ready

Pause | CancelJob |

POFFie | Size | Time |PSFie | Size |[3 Settings | PDF Fold

4| | H

Acrobat Distiler 7.0 N
Started: Thursday, Aprl 14, 2005 at 10:47:35

Adobe PostScript software version: 3016.102




The Standard - Adobe PDF Settings window pops up. On the default General
folder, change the following settings.

* In the Description section enter: Use these settings to create Adobe PDF
documents suitable for compliance with 10CFR1, Appendix A. Created PDF
documents can be opened with Adobe Reader 5.0 and later.

*  From the dropdown menu, set Compatibility to Acrobat 5.0 (PDF 1.4).
* Keep Tags only as the Object Level Compression default.

+ Set Auto-Rotate Pages to Off.

* Keep Left as the Binding default.

+ Set Resolution to 300 dots per inch.

» Verify that All Pages is selected.

» Verify that Optimize for fast web view is checked.

Standard - Adobe PDF Settings
r Description
|Use these settings to create Adobe PDF documents suitable for reliable with
3 Ad d 10CFR1, Appendic A. Created PDF documents can be opened with Adobe Acrobat
vance and Reader 5.0 and later.
[C3 Standards
r File Options
Compatibilty: | Acrobat 5.0 (PDF 1.4) =l
Object Level Comprassion: ITags only j
Auto-Rotate Pages: IOH j
Binding: ILerf't j
Besolution: |3|}|} dots perinch
f* Al Pages
" Pages From: I To: I
[~ Embed thumbnails
¥ Optimize for fast web view
r Default Page Size
Width: [6.5 Units: |[Inches |
[~ Show All Settings Height: I1 10
Save fs... | ok | Cancel | bep |




Select the Images folder and change the fields for all sections as follows:

+ Color Images
Downsample: Off
Compression: ZIP
300 ppi

* Grayscale Images
Downsample: Off
Compression: ZIP
300 ppi

*  Monochrome Images
Downsample: Off
Compression: CCITT Group 4
Anti-alias to gray: Off
450 ppi

Standard - Adobe PDF Settings K |

E I%Elndard ~Color Images
General _ - . .

Downgample: IOH J |3|].|]. pixels perinch

I:l Forts

I:l Calor

[T Advanced

(L] Standards

Compression: IZIF‘ j

—Grayscale Images
Downsample: IOH j |3E'E' pixels perinch

Compression: IZIF‘ j

— Monochrome Images
Downsample: IOH j |45I} pixels perinch

Compression: ICCITI' Group 4 j

Anti-glias to gray: IOH ‘I

Palicy
[ Show All Settings —l
Save fs... | oK | Cancel Help




Click on the Fonts folder and—
+ Verify that the Embed all fonts box is checked.

+ Verify that Subset embedded fonts when percent of characters used is
less than is checked and set at 100%.

* Keep Warn and continue as the default for When embedding fails.

* In the Embedding section, verify that Font Source is set to
C:\WINDOWS\Fonts\ and remove everything in Never Embed (if there is
anything) by selecting everything in the Never Embed field and clicking on

Remove.
Standard - Adobe PDF Settings Ei
[ Standard ¥ Embed all forts
[ General
[£3 Images I | Embed Dpenlype fonts
Farts [+ Subset embedded fonts when percent of characters used is less than: 100 | %
7]
Calor
(3 Advanced 0 Only fonts with appropriate permission bits will be embedded
Standard
(3 Standards When embedding fails: IWam and cortinue j
— Embedding
Font Source: Always Embed
|C:\WINDOWS Fonts' =l =l
T AdLibG | -Hequiar ﬂ
T AgencyFB-Bold fdd - |
T AgencyFB-Reg
T Abertus-ExtraBold
T Abertus-Medium j
T AbetusMT
T AbertusMT-talic M Embed:
T AbertusMT-Light el
T Aldine401BT-BoldA =
T Adine401BT-BoldhalicA
T AdinedD1BT-talicA
T Adine401BT-RomanA A “i|
E Aldine721BT-Bold
Aldine721BT-BoldHhalic
T Aldine721BT-halic 4 =
[T Show All Settings Add Name. . | Bemove |

Save As... | ok | Cancel | Hep |




Click on the Color folder. In the Adobe Color Settings section—
* Make sure Settings File is set to None.

+ Change Color Management Policies to Tag Everything for Color
Management.

+ Keep Document Rendering Intent set to Preserve.
* For the Working Spaces subsection—
» Set Gray to None.

» Keep RGB set to sSRGB IEC61966-2.1.
» Keep CMYK set to U.S Web Coated (SWOP) v2.

In the Device-Dependent Data section—
* Check the Preserve under color removal and black generation option.
+ Set When transfer functions are found to Preserve.

Standard - Adobe PDF Settings

E Standard
[ General r Adobe Color Settings
[ Images Settings File: INane j
[ Fonts
Color
(3 Advanced r—Color Management Policies
(3 Standards Tag Everything for Color Management j
Document Rendering Intent: | Preserve j
~Working Spaces
Gray: I Mane -
RGB: |sRGE IEC51966-2.1 =]
CMYK: | 1.5, Web Coated (SWOP) v2 ;|
¥ Preserve CMYK walues fon calibrated CHMYHK color spaces
r Device-Dependent Data
¥ Preserve under color removal and black generation
When transfer functions are found: IF‘reserve 'l
[ Preserve halftone information

[~ Show All Settings

Save fis... | ok | Cancel Help




Click on the Advanced folder and make sure the following items in the Options
section are selected and checked:

* Allow PostScript file to override Adobe PDF settings.
* Convert gradients to smooth shades.

» Convert smooth lines to curves.

* Preserve Level 2 copypage semantics.

* Preserve overprint settings.

* Overprinting default is nonzero overprinting.

+ Save Adobe PDF settings inside PDF file.

+ Save original JPEG images in PDF if possible.

+ Save Portable Job Ticket inside PDF file.

The following items should be checked and enabled in the Document Structuring
Conventions section:

*  Process DSC comments.

*  Preserve EPS information from DSC.

* Preserve OPl comments.

* Preserve document information from DSC.

* Resize page and center artwork for EPS files.

Standard - Adobe PDF Settings E3

E Standard ~ Options
(1 General ¥ Alow PostScript file to ovenide Adobe PDF settings
% 'F”;Ia_rtg:S I Allow PostScript XObjects
(2 Color ¥ Convert gradients to smooth shades
¥ Conyert smooth lines to curves
[ Standards

¥ Preserve Level 2 copypage semantics
¥ Preserve averprnt settings
v Overprinting defautt is nonzero overprinting
¥ Save Adobe PDF settings inside PDF file
¥ Save original JPEG images in POF ff possible
¥ Save Portable Job Ticket inside PDF file
[ Use Prologue ps and Epilogue ps
I~ Create Job Definition Format (JDF) file

r Document Structuring Conventions (DSC)
¥ Process DSC comments

[ Log DSC wamings

¥ Preserve EPS information from DSC

¥ Preserve OP| comments

¥ Preserve documert information from DSC
¥ Besize page and center artwork for EP'S files

[~ Show All Settings

Save As. . | QK I Cancel Help




Click on the Standards folder. Leave everything as is in the Standards Reporting
and Compliance section and verify that Compliance Standard is set to None.

standard - Adobe PDF Settings

E %‘:mgard | ~ Standards Reporting and Compliance
Eneral
3 Images Compliance Standard: I None ;I

% EU'I“S When not compliant: ICDI‘ItinLIB j
olor

(23 Advanced

Standards

 If Netther TrimBox nor ArtBox are Specified
& Feport &3 ermor
€ Set TrimBox b M ediaBox with offsets (Paints);

Left: |0.0 Bight: |0.0 Top: IC.C Bottom: |0.0

I BleedBox is Mot Specified
& SetBleedBon to MedisBion
£ Set BleedB og to TirimB o with offsets (Points):

Left: [0.0 Right: [0.0 Top: [00 Bottom: [0.0

r Default Values f Mot Specified in the Document

Output Intert Profile Name: | Nonz = |

Output Condition |dentifier: |

|
QOutput Condition: I ﬁ
|
o]

Registry Name (URL): |
Trapped: IInsert False j 5

[~ Show All Settings

Save fs... | ok | Cancel | bep |

Click on e, |in the bottom left corner of the window to save the changes.

In the File Name field, enter NRC-10CFR1.joboptions as a new profile name (or
whatever name you want to call it). Click on| e | m Then

Save Adobe PDF Settings As

Savein: IL'f} Settings LI ) ¥ P -

SiHigh Quality Print. joboptions;
% RC-10CFR 1. joboptions

' PDFA DRAFT . joboptions

o PDFX1a 2001.joboptions

~ PDFX3 2002.joboptions

& Press Quality. joboptions

& smallest File Size.joboptions
 Standard.joboptions

NRC Network

File name: INRC—‘I OCFR1 joboptions LI Save I
Save as type: IA«:IUIJE PDF Settings Files (" joboptions) LI Cancel |

e




The Acrobat Distiller window now pops up. Verify that Default Settings is set to
your newly created profile (for example, “NRC-10CFR1"), as in the screen below.

Acrobat Distiller M=

File Settngs Help

r Adobe POF Settings
Default Settings:
Compatibility: Acrobat 5.0 (FDF 1.4)

Use these settings to create POF Documents suitable for compliance with
i/ 10CFR1. Appendix A

 Progress
Status: Ready
Pause | CancelJob |

POFFile [ Size [ Tme |[PSFle | Size |[3 Settings | PDF Fold

<4 I

Il 1=

Acrobat Distiller 7.0
Started: Tuesday, Aprl 19, 2005 at 9:17.33

Adobe PostScript software version: 3016.102

Select File =EXxit or click on il to close Acrobat Distiller.

IR Acrobat Distiller =]

File Settings Help
QOpen... Cirl+0 |

Preferences... Ctrl+K

ate PDF Documents suitable for compliance with

%/ 10CFR1, Appendix A

— Progress
Status: Ready
Pause | LCancelJob I
PDOFFle [ Size | Tme |[PSFle | Sze |[3 Settings | PDF Fold
< ] ©
Acrobat Distiller 7.0 =1
Started: Tuesday, April 15, 2005 at 5:17:33
Adobe PostScript software version: 3016.102




It is important to set the preferences in Adobe Acrobat so you can convert different
types of documents to PDF while in Adobe Acrobat.

From the main menu, click on Edit => Preferences to set the preferences.

¥R Adobe Acrobat Professional Mi=] B3
File | Edit View Document Comments Tools Advanced Window Help
= = o Ty- —
= E 2 Undo Girl+z h_l " = ﬁ Create POF ~ |N€l Comment & Markup ~ Eﬁ - - é - LEE -
Redo Shift+Cir] +2
SN 5 = £ -
: q L o @ Joo - @ [EDY- 1 v i @tew
Cut Ctrl 4%
3 copy CHrl+E
[%] past= Chrl+y

Delets

Copy Fle to Clipboard

Cirl+A

Select All
Deselect All Shift-HE ]+

Check Spelling
Add Bookmark

Lookup Definition. ..

Eind




In the Preferences window, select Convert To PDF option from the Categories
subwindow. You will see a list of application in the Convert to PDF subwindow.
One of these applications may be the application used to create your document.
The screen below gives configuration instructions for Microsoft Office, Project, and
Publisher documents and TIFF images. Select and change the configurations for
your application.

Microsoft Office

. Select Microsoft Office and click on _Htsings.. |

Categories: r Converting To PDF
.il:c)cessibility = ;I:‘;DDESk AutoCAD = Click Edit Settings to view or edit settings for this file type.
Batch Processing Compuserve GIF
Catalog HTML
Color Management JDF Job Definition
Commenting JPEG
Conwvert From PDF JPEG2000
Conwvert To PDF
Forms Microsoft Project
Full Screen Microsoft Publisher
General Microsoft Visio
Identity PCX
International PNG
Internet PostScript/EPS L
JavaScript Text
Measuring TIFF LI
Multimedia : .
Page Display M&
Reading
Reviewing
Search
Security
Spelling
Startup
TouchUp
Trust Manager
Units & Guides —
Updates
Web Capture LI
OK I Cancel |

In the Adobe PDF Settings for supported documents window, click on the
dropdown menu and select the newly created profile (for example, “NRC-
10CFR1").

Adobe PDF Settings for supported documents

Adobe PDF Settings: |MRC-10CFR1

High Quality Print

Adobe PDF Security:

PDF/A:Draft
¥ Enable accessibility FDFf%-12:2001

¥ Add bookmarks and PDF/%-3:2002
[ Convert entire Exc Press Quality

Smallest File Size
Standard

o]




Click on Convert entire Excel workbook to ensure that the conversion of the
whole Excel workbook is supported. Then click on  *

Adobe PDF Settings for supported documents | x| |
Adobe PDF Settings: INRC-lDCFRl =] Edit...
Adobe PDF Security: |Nane | Edit. ..

W Enable accessibility and reflow
W Add bookmarks and links to Adobe PDF file
¥ Convert entire Excel ﬂurkbnu%

K Cancel

Microsoft Project

+ Select Microsoft Project and click on EdtStin... | )

In the Adobe PDF Settings window, click on the dropdown menu and select

the newly created profile (in this example, “NRC-10CFR1"). Then click on
0K

Adobe PDF Settings |

Adobe PDF Settings:  |High Quality Print j Edit...
High Quality Print

Adobe POF Security: Edit...
POFfA:Draft
FOFX-1a: 2001 Cancel
PDF/X-3:2002 -

Microsoft Publisher

. Select Microsoft Publisher and click on _Edtsinc.. | button.

In the Adobe PDF Settings for supported documents window, click on the
dropdown menu and select the newly created profile (in this example, “NRC-
10CFR1"). Verify that Add bookmarks and links to Adobe PDF file is
selected (This step is optional but recommended). Then click on % |,



Adobe PDF Settings for supported documents |

Adobe PDF Settings: |MRC-10CFR1 bl Edit... |
High Quality Print

Adobe POF Security: Edlit... |
PDF/a:Draft
FDFfX-13:2001
¥ Add bookmarks and FOFf%-3:2002
Press Quality
Smallest File Size
oK I Standard

TIFF

- Select TIFF then click on _Etsetings.. |

Preferences

Categories: r Converting To PDF
0 = BMP ;I Manochrome Compression: CCITT G4
Accessibility Compuserve GIF Graysczle Comprassion: JPEG (Quality : Medium)
Batch Processing HTML Calor C\:!r'p'asbn: JPEG (Qruality : hl-1eci..r"::
Catalog I0F Job Definition RGB Policy: Preserve embedded profies
CMYK Policy: Off
Color Management JPEG Gray Palicy: OF
Commenting JPEG2000 Cither Palicy: Preserve embedded profiles
Convert From PDF Microsoft Office
Convert To PDF Microsoft Project
Forms Microsoft Publisher
Full Screen Microsoft Visio
General PCX
Identity PNG
International PaostSoript/EPS
Internet Text
JavaScript TIRF —%
Measuring -
Multimedia
Page Display
Reading
Reviewing
Search
Security
Spelling
Startup
TouchUp
Trust Manager
Units & Guides ||
Updates
Web Capture LI

0K Cancel




The Adobe PDF Settings window appears with the default settings.
AdobePDFsettngs 3|

— Compression

Monochrome: ICCI‘I‘I’ G4

Grayscale: IJPEG (Quality Mel%m)

Lef Lo Lo

Color: IJPEG (Quality : Medium)

— Color Management

RGE: IPreserve embedded profiles

=
cmvk:  [off |
Grayscale: j

[l iy = Preserve embedded pro

* Change the settings in the Compression section as follows:

» Set Grayscale to ZIP.
» Set Color to ZIP.
» Leave the rest as is.

Adobe PDF Settings E2 |

— Compression
Monochrome: ICCl‘I‘I’G4 j
[
Grayscale: IZIF‘ j

Color: IZIP j

— Color Management

RGE: eserve embedded profiles
cv:  [off =]
Grayscale: IOFF j

QOther: IPreserve embedded profiles j

oK I Defaults | Cancel |

e Clickon o |

Click on Ll again in the Preferences window.



4.1.4 m Adobe Acrobat 8.0 Professional

Note: You can download and install a Distiller Job Options file (profile) created by NRC
by following instructions in question 7 of the FAQs section.

Launch Adobe Acrobat Distiller by clicking on Windows Start ©> Programs =>
Adobe Acrobat Distiller 8 or while in Adobe Acrobat Professional, select Advanced
= Print Production => Acrobat Distiller.

Adobe Acrobat Professional
File Edit View Document Comments Forms Tools | Advanced Window Help

ﬁ Create PDF = @ Combine Files + @ Export A sign s certfy

HEl B3

@ Forms - 9 Review & Comment
{2 | Find hd

v v

i ﬁ Security

i w0 so

=

sy b

Security Settings...

Manage Trusted Identities.. .

Enable Usage Rights in Adobe Reader...

Compare Documents...

The Acrobat Distiller window pops up.

B Acrobat Distiller
Flle Settings Help

Print Production Acrobat Distiller
Redaction Lol Qverprint Preview Shift+Ctrl+7
Document Processing r ¢ | Output Preview...
Web Capture » o erefiight... Shift+Ctrl+%
Arcessibility 3 3| Trap Presets. ..
PDF Optimizer. .. [} Convert Colors...

78 preflight... Shift+Ctrl+% 2, Ink Manager

‘| Add Printer Marks. ..
5 Crop Pages
4| Fix Hairlines. ..
Flattener Preview
G0 PDF Optimizer. ..
#f IDF Job Definitions. ..

Show Print Production Toolbar

HE B3

r Adobe PDF Settings

Defauit Settings: [Emeesc I -
Compatibiity:  Acrobat 5.0 (PDF 1.4)

lse these seftings to create Adobe POF documents suitable for reliable
viewing and printing of business documents. Created PDF documents can
be opened with Acrobat and Adobe Reader 5.0 and later.

"

— Progress
Status: Ready

LancelJab |

Pause |

PDF File Size Time PS File Size Settings | PDF Fold

|

Acrobat Distiller 8.0
Started: Thursday, March 15, 2007 at 10:49:28

fdobe PostScript software version: 3016.102
CID support library initislization completed.




Change the settings by going to the pulldown menu and selecting Settings => Edit
Adobe PDF Settings.

B Acrobat Distiller H=1 B
Eile m Help

— &y Font Locations... Cirl-+H |
Watched Eolders. .. Ctrl+F

Edit Adobe POF Settings...
Add Adobe PDF Settings...
(; Remove Adobe PDF Settings... Ctrl+R

suitable for reliable
d POF documents can

Security... Ctrl+5 later.
— Progress
Status: Feady
Pause | Eancellob |

POFFle | Sze | Tme |PSFle | Sze | [® Settings | PDF Fold

d | ©

Acrobat Distiller 8.0 =
Started: Thursday, March 15, 2007 at 10:45:28

Adobe PostScript software wersion: 3016.102
CI0 support librany inttialization completed.




The Standard - Adobe PDF Settings window pops up. On the default General
folder, change the following settings.

* In the Description section enter: Use these settings to create Adobe PDF
documents suitable for compliance with 10CFR1, Appendix A. Created PDF
documents can be opened with Adobe Reader 5.0 and later.

*  From the dropdown menu, set Compatibility to Acrobat 5.0 (PDF 1.4).
* Keep Tags only as the Object Level Compression default.

+ Set Auto-Rotate Pages to Off.

* Keep Left as the Binding default.

+ Set Resolution to 300 dots per inch.

» Verify that All Pages is selected.

» Verify that Optimize for fast web view is checked.

Standard - Adobe PDF Settings
r Description
|Use these settings to create Adobe PDF documents suitable for reliable with
3 Ad d 10CFR1, Appendic A. Created PDF documents can be opened with Adobe Acrobat
vance and Reader 5.0 and later.
[C3 Standards
r File Options
Compatibilty: | Acrobat 5.0 (PDF 1.4) =l
Object Level Comprassion: ITags only j
Auto-Rotate Pages: IOH j
Binding: ILerf't j
Besolution: |3|}|} dots perinch
f* Al Pages
" Pages From: I To: I
[~ Embed thumbnails
¥ Optimize for fast web view
r Default Page Size
Width: [6.5 Units: |[Inches |
[~ Show All Settings Height: I1 10
Save fs... | ok | Cancel | bep |




Select the Images folder and change the fields for all sections as follows:

+ Color Images
Downsample: Off
Compression: ZIP
300 ppi

* Grayscale Images
Downsample: Off
Compression: ZIP
300 ppi

*  Monochrome Images
Downsample: Off
Compression: CCITT Group 4
Anti-alias to gray: Off
450 ppi

Standard - Adobe PDF Settings K |

E I%Elndard ~Color Images
General _ - . .

Downgample: IOH J |3|].|]. pixels perinch

I:l Forts

I:l Calor

[T Advanced

(L] Standards

Compression: IZIF‘ j

—Grayscale Images
Downsample: IOH j |3E'E' pixels perinch

Compression: IZIF‘ j

— Monochrome Images
Downsample: IOH j |45I} pixels perinch

Compression: ICCITI' Group 4 j

Anti-glias to gray: IOH ‘I

Palicy
[ Show All Settings —l
Save fs... | oK | Cancel Help




Click on the Fonts folder and—
+ Verify that the Embed all fonts box is checked.

+ Verify that Subset embedded fonts when percent of characters used is
less than is checked and set at 100%.

* Keep Warn and continue as the default for When embedding fails.

* In the Embedding section, verify that Font Source is set to
C:\WINDOWS\Fonts\ and remove everything in Never Embed (if there is
anything) by selecting everything in the Never Embed field and clicking on

Remove.
Standard - Adobe PDF Settings Ei
[ Standard ¥ Embed all forts
[ General
[£3 Images I | Embed Dpenlype fonts
Farts [+ Subset embedded fonts when percent of characters used is less than: 100 | %
7]
Calor
(3 Advanced 0 Only fonts with appropriate permission bits will be embedded
Standard
(3 Standards When embedding fails: IWam and cortinue j
— Embedding
Font Source: Always Embed
|C:\WINDOWS Fonts' =l =l
T AdLibG | -Hequiar ﬂ
T AgencyFB-Bold fdd - |
T AgencyFB-Reg
T Abertus-ExtraBold
T Abertus-Medium j
T AbetusMT
T AbertusMT-talic M Embed:
T AbertusMT-Light el
T Aldine401BT-BoldA =
T Adine401BT-BoldhalicA
T AdinedD1BT-talicA
T Adine401BT-RomanA A “i|
E Aldine721BT-Bold
Aldine721BT-BoldHhalic
T Aldine721BT-halic 4 =
[T Show All Settings Add Name. . | Bemove |

Save As... | ok | Cancel | Hep |




Click on the Color folder. In the Adobe Color Settings section—
* Make sure Settings File is set to None.

+ Change Color Management Policies to Tag Everything for Color
Management.

+ Keep Document Rendering Intent set to Preserve.
* For the Working Spaces subsection—
» Set Gray to None.

» Keep RGB set to sSRGB IEC61966-2.1.
» Keep CMYK set to U.S Web Coated (SWOP) v2.

In the Device-Dependent Data section—
* Check the Preserve under color removal and black generation option.
+ Set When transfer functions are found to Preserve.

Standard - Adobe PDF Settings

E Standard
[ General r Adobe Color Settings
[ Images Settings File: INane j
[ Fonts
Color
(3 Advanced r—Color Management Policies
(3 Standards Tag Everything for Color Management j
Document Rendering Intent: | Preserve j
~Working Spaces
Gray: I Mane -
RGB: |sRGE IEC51966-2.1 =]
CMYK: | 1.5, Web Coated (SWOP) v2 ;|
¥ Preserve CMYK walues fon calibrated CHMYHK color spaces
r Device-Dependent Data
¥ Preserve under color removal and black generation
When transfer functions are found: IF‘reserve 'l
[ Preserve halftone information

[~ Show All Settings

Save fis... | ok | Cancel Help




Click on the Advanced folder and make sure the following items in the Options
section are selected and checked:

* Allow PostScript file to override Adobe PDF settings.
* Convert gradients to smooth shades.

» Convert smooth lines to curves.

* Preserve Level 2 copypage semantics.

* Preserve overprint settings.

* Overprinting default is nonzero overprinting.

+ Save Adobe PDF settings inside PDF file.

+ Save original JPEG images in PDF if possible.

+ Save Portable Job Ticket inside PDF file.

The following items should be checked and enabled in the Document Structuring
Conventions section:

*  Process DSC comments.

*  Preserve EPS information from DSC.

* Preserve OPl comments.

* Preserve document information from DSC.

* Resize page and center artwork for EPS files.

Standard - Adobe PDF Settings E3

E Standard ~ Options
(1 General ¥ Alow PostScript file to ovenide Adobe PDF settings
% 'F”;Ia_rtg:S I Allow PostScript XObjects
(2 Color ¥ Convert gradients to smooth shades
¥ Conyert smooth lines to curves
[ Standards

¥ Preserve Level 2 copypage semantics
¥ Preserve averprnt settings
v Overprinting defautt is nonzero overprinting
¥ Save Adobe PDF settings inside PDF file
¥ Save original JPEG images in POF ff possible
¥ Save Portable Job Ticket inside PDF file
[ Use Prologue ps and Epilogue ps
I~ Create Job Definition Format (JDF) file

r Document Structuring Conventions (DSC)
¥ Process DSC comments

[ Log DSC wamings

¥ Preserve EPS information from DSC

¥ Preserve OP| comments

¥ Preserve documert information from DSC
¥ Besize page and center artwork for EP'S files

[~ Show All Settings

Save As. . | QK I Cancel Help




Click on the Standards folder. Leave everything as is in the Standards Reporting
and Compliance section and verify that Compliance Standard is set to None.

Standard - Adobe PDF Settings
E %_:m(;::iml r Standards Reporting and Compliance

(3 Images Compliance Standard: I None |

% EZII:: When not compliant: ICDntinue j

(3 Advanced

Standards I Neither TrimBox nor ArtBax are Specified

& Feport &3 ermor
€ Set TrimBox b M ediaBox with offsets (Paints);
Left: |0.0 Bight: |0.0 Top: IC.C Bottom: |0.0

I BleedBox is Mot Specified
& SetBleedBon to MedisBion
£ Set BleedB og to TirimB o with offsets (Points):

Left: [0.0 Right: [0.0 Top: [00 Bottom: [0.0

r Default Values f Mot Specified in the Document
Output Intert Profile Name: | None =l .gl

Output Condition |dentifier: |

QOutput Condition: I
Registry Name (URL): I
Trapped: IInsert False j

sl |

[~ Show All Settings

Save fs... | ok | Cancel | bep |

Click on e, |in the bottom left corner of the window to save the changes.

In the File Name field, enter NRC-10CFR1_8.joboptions as a new profile name (or
whatever name you want to call it). Clickon| s |. Then & |.

Save Adobe PDF Settings As 2=
Savein: I@ Settings j = &5 B

_’ MRC-10CFR 1_7.joboptions

File name: INRC-‘I OCFR1_8 jobaoptions d Save I
Save as type: I.—'ldobe PDF Settings Files (*joboptions) d Cancel |
E




The Acrobat Distiller window now pops up. Verify that Default Settings is set to
your newly created profile (for example, “NRC-10CFR1_8"), as in the screen below.

B Acrobat Distiller HE B

File Settings Help
—Adobe PDF Settings
Default Settings: [ NAC-10CFR1_E =

Compatibility:  Acrobat 5.0 (PDF 1.4)

|Jze these settings to create Adobe PDF documents suitable for compliance
Q with T0CFR1, Appendix A, Created POF documents can be opened with
Adobe Reader 5.0 and later.

— Progress
Status: Ready
Pause | LCancell/ob |
POFFle | Size | Time | PSFle | Size | [ Seftings | PDF Fold

. | H

Acmobat Distiler 8.0 =l
Started: Thursday, March 15, 2007 at 10:45:28

Adobe PostScript software version: 2016.102
CID support library initizlization completed.

Select File =EXxit or click on il to close Acrobat Distiller.

B Acrobat Distiller [=[o]x]
File Settings Help

Qpen. .. Cirl+0

Preferences.., Cirl+K -10CFR1_8 d

Q with 1DC R1, Appendix & Created PDF documents can be opened with
Adobe Reader 5.0 and later.

— Frogress
Status: Ready
| |
Pause | LancelJob I

POFFle | Sze |Tme |PSFle | Size |[[3 Setiings | PDF Fold

< | ®

Acrobat Distiler 8.0 =
Started: Thursday, March 15, 2007 at 10:45:28

Adobe PostSeript software version: 3016.102
CID support library intialization completed.




It is important to set the preferences in Adobe Acrobat so you can convert different
types of documents to PDF while in Adobe Acrobat.

From the main menu, click on Edit => Preferences to set the preferences.

Adobe Acrobat Professional H= B
File [ Edit View Document Comments Forms Tools Advanced Window Help

£ Undo Crl+Z @ Export ~ @ Start Mesting ﬁ Secure v , Sign ~ @ Forms - & Review & Comment ~

3 Redo shift+Ctrl+Z
iC /o | Ik e

cut Ctrl+X

Copy Ctrl+C
2 paste Cirl+v

Delete

Copy File to Clipboard

Select All Cirl+a
Deselect Al Shift+Ctrl+a

Check Spelling
Look Up Selected Word...

Find Cirl+F
Search Shift+Ctrl+F

Search Results




In the Preferences window, select Convert To PDF option from the Categories
subwindow. You will see a list of application in the Convert to PDF subwindow.
One of these applications may be the application used to create your document.
The screen below gives configuration instructions for Microsoft Office, Project, and
Publisher documents and TIFF images. Select and change the configurations for
your application.

Microsoft Office Word

- Select Microsoft Office Word and click on % .

Preferences B

Categories: r Converting To PDF

Commenting = Autodesk AutoCAD = Click Edit Settings to view or edit settings for this file type.
Documents BEMP

Full Screen Compuserve GIF

General HTML

Page Display InDesign

_— JDF Job Definition

D JPEG

Accessibility JPEG2000

Batch Processing Microsoft Office Excel

Catalog Microsoft Office PowerPoi

Color Management Microsoft Office Project =

Convert From PDF

Convert To PDF Microsoft Publisher

Forms PCX

Identity ‘3"‘ I ;l;l

International

Internet Edit Settings... |
JavaScript

Measuring (20

Measuring (30

Meeting

Multimedia

Multimedia Trust

Mew Document
Online Services
Reading
Reviewing
Search

Sarurity ;I

oK I Cancel |

In the Adobe PDF Settings for supported documents window, click on the
dropdown menu and select the newly created profile (for example, “NRC-
10CFR1_8").

Adobe PDF Settings for supported documents B
Adobe PDF Settings: |MRC-10CFR1_8 d Edit... |

Qversized Pages o
Adabe PDF Security: | POF/a-1h:2005 (CMYK) Edli... |
~ PDF/a-1b: 2005 (RGE)
v Add bookmarks 0 4one o 1200
¥ add links to Adobe [PDF/%-3:2002
[¥ Enable accessibility|Fress Quality
Smallest File Size
Standard

MRC-10CFR1_7

1




Microsoft Office Excel

« Select Microsoft Office Exel and click on _Edtting... | )

In the Adobe PDF Settings for supported documents window, click on the

dropdown menu and select the newly created profile (for example, “NRC-
10CFR1_8").

Click on Convert entire Excel workbook to ensure that the conversion of the
whole Excel workbook is supported. Then click on *

Adobe PDF Settings for supported documents x|

Adobe PDF Settings: IHRC- 10CFR1_8 d Edit... |
Adobe PDF Security: Ir—lone j Edit. .. |

¥ Add bookmarks to Adobe POF file
[V add links to Adobe POF file
¥ Enable accessibility and reflow

[w Convert entire Excel workbook:

oK I Cancel

Microsoft Office PowerPoint

« Select Microsoft Office PowerPoint and click on EditSttngs. |

In the Adobe PDF Settings for supported documents window, click on the

dropdown menu and select the newly created profile (for example, “NRC-
10CFR1_8").

Adobe PDF Settings for supported documents B
Adobe PDF Settings: |MRC-10CFR1_8 d Edit... |
Qversized Pages o

Adobe POF Segurity: PDF/A-1b: 2005 {CMYK) Edit... |

o PDF /A-1b:2005 (RGE)
v/ Add bookmarks 10 1, 15001

I¥ Add links to Adobe |POF/%-3:2002
[¥ Enable accessibility|Fress Quality
Smallest File Size
Standard

MRC-10CFR1_7




Microsoft Office Project

+ Select Microsoft Office Project and click on Edtsings.. |

In the Adobe PDF Settings window, click on the dropdown menu and select
the newly created profile (in this example, “NRC-10CFR1_8"). Leave Adobe

PDF Security as “None”. Then click on =

Adobe PDF Settings:

Adobe PDF Security:

Cversized Pages
POF/A-1b: 2005 (CMYK)
POF/A-1b: 2005 (RGE)
PDF/¥-12:2001
PDF/%-3:2002

Press Quality

Microsoft Publisher

. Select Microsoft Publisher and click on _Edtsinc.. |

In the Adobe PDF Settings window, click on the dropdown menu and select
the newly created profile (in this example, “NRC-10CFR1_8"). Leave Adobe

- Edit... |

Edit. .. |
Cancel |

smallest File Size
Standard
MRC-10CFR1_7

W

PDF Security as “None”. Then click on = 0

AdobePDFSettings [

Adobe PDF Settings:

Adobe PDF Security:

Oversized Pages o
PDF/4-1b: 2005 {CMYE)

PDF/A-1b; 2005 (REE)

PDFX-15:2001

PDF/%-32002

Press Quality

Edit...

Edit...

dili

Cancel

smallest File Size
Standard
MRC-10CFR1_7

W




TIFF

«  Select TIFF then click on _itstings.. |

The Adobe PDF Settings window appears with the default settings.

Preferences

Categories:  Converting To PDF
kin) -] EMP ;I Monachrome Compression: CCITT G4
Accessibility Compuserve GIF Grayzczle Compression: JPEG (Qualiny : Medium)
Batch Processing HTML Color Compression: JPEG (GQruslity : Medium)
. RGE Palicy: Preserve embedded profiles
Catalog JDF Job Definition CMYK Policy: OFF
Color Management JPEG Gray Palicy: OF
Commenting JPEG2000 Other Policy: Preserve embedded profiles
Convert From PDF Microsoft Office
Convert To PDF Microsoft Project
Forms Microsoft Publisher
Full Screen Microsoft Visio
General PCX
Identity PNG
International PostScript/EPS
Internet Text
JavaScript TIFF —%
Measuring =
Multimedia
Page Display
Reading
Reviewing
Search
Security
Spelling
Startup
TouchUp
Trust Manager
Units & Guides —
Updates
Web Capture LI

O

Cancel

Adobe PDF Settings

— Compression

Monochrome: ICCI‘I‘I’ [=2] ﬂ

Grayscale: IJPEG (Quality : Mel@m) ﬂ

Color: IJPEG (Quality : Medium) ﬂ
— Color Management
RGB: IPreserve embedded profiles j
cmvi:  [off =]
Grayscale: j
QOther:

Defaults | Cancel |




* Change the settings in the Compression section as follows:

» Set Grayscale to ZIP.
» Set Color to ZIP.
» Leave the rest as is.

AdobePFsettings |
— Compression
Monochrome: |CCITT G4 =]
Grayscale: |zIP ]
Color: [z1P ]

— Color Management

eserve embedded profiles

Grayscale:

QOther: IPreserve embedded profiles j

oK I Defaults | Cancel |

e Clickon o |

Click on Ll again in the Preferences window.



4.2 Setting up and configuring Adobe Preflight for—
421 = Adobe Acrobat 6.0 Professional

Note: You can download and install a NRC created Adobe Preflight profile by following
instructions in question 8 of the FAQs section.

* Launch Adobe Acrobat 6.0 Professional.
* From the main menu, click on Document and select Preflight.
» Click on the Edit button to bring up the Preflight: Edit profiles window.

Adobe A bat P o a L]
File Edit View Tools Advanced Window Help
% B t& F o 4 jﬂﬂﬁﬂw&mm - El'aacure - ZSign - |—_E| -

A Digital Signatures

Paper Capture

| Prefiight...

r

Preflight: Profiles

Sample profile

Features newer than POF 1.2
Features newerthan PDF 1.3
Features newer than PDF 1.4
List all images

List all objects not 4c

Ligt all objects not 4c or spot

List all overprnting objects

Ligt all potential problems

List all transparent objects

List JPEG compressed images
More than 1 plate

Maore than Z plates

More than 4 plates

Mot supported in PostScript 3
Mot supported in PostScript Lewvel 1
Mot supported in PostScript Lewvel 2
Output not 1007% predictable
PDF/¥-1a compliant

PDF/X-3 compliant {4c+spot)
PDF./ -3 compliant {ICC/Lab OK)

Validation... »

PDF/X. ..




+ In the Preflight: Edit profiles window, click on 11| to create a new profile designate to
NRC.

Preflight: Edit profiles

Profiles: Rules: Conditions:

- Sample rule Al | e @ Sample condition -
Features newerthan FDF 1.2 [~ @ Agrobat Forms inside pagearea | | 0 | i @ Acrobat Forms inside page area
Features newerthan FDF 1.3 [~ @ Atemate color space not PDF/-1a | | | & @ Altemate color space not CMYK ar €

© " Features newerthan FOF 1.4 - @ Atemate image settopint | | B @ Altemate image default for printing

0 List allimages M- @ Annotations inside pagearea | | | B @ Annotation inside page area

@7 List all objects not 4c [~ @) Bitmap res. lessthan 1000ppi | | & @ ArtBox is missing

% List all objects not 4c or spot [~ @) Bitmap res. lessthan 1200ppi | | & @ Bitmap image

@7 List all overprinting objects [#- @) Bitmap res. lessthan 500ppi | | i @ BX. EXused

List all potertial problems [~ @ Bitmap res. more than 3000ppi | | i @ Color managed color used

7 List all transparent objects [~ @ BX¥..EXinpage descripton | | B @ Contains more than one page

" List JPEG compressed images [~ @ Contains more than one page ™ | | &= @ Courier used

) Mare than 1 plate - @ Created with PDPWiter | | & @ Created with PDPWriter

) More than 2 plates M- @ Creation datemissing | | i~ @ Distiled with "=Book”

¥ More than 4 plates J [~ @ DestOutputProfile missing J ----- @ Distiled with ""High Guality"

% Not supported in PostScript 3 [~ @ Distiled with "eBook™ | | - @ Distiled with "PDFX1a"

% Not supported in PostScript Level 1 J [#- & Distiled with "High Quality” J ----- @ Distiled with "PDFX3"

7 Not supported in PostScript Level 2 [~ @ Digtiled with "PDF¥1a" | | &= @ Distilled with "Press”

©* Output not 100% predictable H- @ Ditiled with "PDFX3" | | i~ @ Distiled with "Print"

‘W PDF/¥-1a compliart [ @ Distiled with "Press” | | B~ @ Distiled with "Screen”

‘W PDF/%-3 compliant (4c+spat) - @ Distiled with "Pirt” | | B @ Distiled with "Smallest Filz Size”
[#- “d POF/%-3 compliant (ICC/Lab OK) [~ @ Distiled with "Screen™ | | & @ Distiled with "Standard"

- @ Distiled with "Smallest Flle Size” | | i~ @ Documert author empty/missing A
LUse this sample profile for trying out
something.
iﬂ’%@@mﬂﬂ oo ] e i Y ua ] e i Y
[ ok [ camed | [ sy |

Preflight: Edit profile

MName for this profile:

[NRC-10CFR1 |

Description:

oK Rl[ Cancel

* Create a new name for the profile (e.g., “NRC-10CFR1").



» Select the following in the Rules section and click on the double left arrow to add to the
new Preflight profile:

» Bitmap resolution less than 300 ppi
» Font not embedded

» Image resolution less than 300 ppi
» PDF version newer than 1.4

+ Clickon % [when finish.

Prefli dit profiles

Profiles Rules: Conditions
* List allimages - -8 Sample nle ~ @ Sample condtion ~
List all objects not 4c [~ Acrobat Forms inside page area - @ Acrobat Forms inside page area
List all objects not 4c or spot - Atemate color space not PDF/%-1a - @ Atemate color space not CMYK or C
List all overprinting objects [0 Atemate image set to print @ Atemate image default for prirting
List 2l potertial problems - Annotations inside page area -~ @ Annctation inside page arsa
List all transparent objects - & Btmap res. less than 1000 ppi @ AtBoxis missing
List JPEG compressed images - &) Bitmap res. less than 1200 ppi @ Bitmap image
Mare than 1 plate -3 Bitmap res. less than 300 ppi -~ @ BX...EXused
More than 2 plates - & Bitmap res. more than 3000 ppi @ Color managed color used
Mare than 4 plates [~ %9 BX..EXin page description @ Contains more than one page
Not supported in PostScript 3 - @ Contains more than one page - @ Courier used
Not supported in PostScript Level 1 B @ Created with PDFWriter @ Created with PDFWriter
Not supported in PostScript Level 2 - &) Creation date missing - @ Distiled with "eBook"
J @ DestOutputProfile missing J @ Distlled with "High Quality”
) Bitmap res. less than 300 ppi - & Distiled with "eBook™ - @ Distiled with "PDFX1a"
@ Font not embedded J (- @ Distiled with "High Quality" J @ Distiled with "PDFX3"
@ Image res. less than 300 ppi - @ Distiled with "PDFX1a" - @ Distiled with "Press"
@ PDF version newer than 1.4 (- @ Distiled with "PDFX3" @ Distiled with "Prirt"
Cutput not 100% predictable -9 Digtiled with "Press” - @ Distiled with "Screen”
i PDF/X-1a compliant - Distiled with "Prirt” - @ Distiled with "Smallest File Size"
# PDF/¥-3 compliant (4c+spot) [ @ Distiled with "Screen” - @ Distiled with "Standard”
# PDF/¥-3 compliant (ICC/Lab OK) & -0 Digtiled with "Smallest File Size"  a - @ Document author empty/missing &
B0 ¥ 3] = - ) e Y B 0 o] 3
‘h Cancel ] [ Apply ]

Preflight: Profiles

Sample profile

Features newer than PDF 1.2
Features newer than PDF 1.3
Features newer than PDF 1.4

List all images

List all objects not 4c

List all objects not 4c or spot

List all overprinting objects

List all potential problems

List all transparent objects

List JPEG compressed images
More than 1 plate

More than 2 plates

More than 4 plates

Mot supported in PostScript 3

Mot supported in PostScript Level 1
Mot supported in PostScript Level 2

Output not 100% predictable
PDF/%-1a compliant
PDF/%-3 compliant (4c+spot)

PDR/C3 compliant (ICC/L=0 OK) The new Preflight profile is created

and can be used later for testing. See
section 6.4.




4.2.2 m Adobe Acrobat 7.0 Professional

Note: You can download and install a NRC created Adobe Preflight profile by following
instructions in question 8 of the FAQs section.

» Launch Adobe Acrobat 7.0 Professional.
* From the main menu, click on Advanced and select Preflight.

8 Adobe Acrobat Professional
File Edit View Document Comments Tools | Advanced Window Help

& H2E & & Accessiility ’erun'gs_l" - A=
- Acrobat Distiler -

&M T Select Eﬂ @ - [ atch Processing.. 1 | @ Heb -
B @ l-H- comko.

Digital Editions
Export Al Images. ..
Forms

JavaSaipt

Links

Migrate Comments...
Number Pages. ..
POF Gptimizer...
Security Settings...
Trusted Identities. ..
\Web Capture

Use Local Fonts Shift+Ctrl+¥

Qyerprint Preview Shift+Etr]+7

1B Profiles '\ﬁﬂesuhs| ﬂﬂeport 1 Comments i‘.-..«. -

Select a profile for preflighting the cument PDF:

etfed oo vty Pt colors. medium r==.) « From the Preflight window,
Wt e o CMYIC o ot colors. medium res) N select a profile and click on Edit

Web offset (cold set. CMYK. medium res_)
Web offsct (heat set. CMYK and spot colors) from the menu bar.
Web offset (heat set. CMYK)
Compatibility with Acrobat 3
Compatibility with Acrobat 4
Compatlbllrty with Acrobat 5

ikl it Aepnbot O
F‘Lrposeoftheseleded Preflight profile:
‘Werifies whether the PDF is compliant with PDFAA (Draft). ;I

T Ereflight only pages I‘I Lo I'I
Execute |

PDF/X status of cument document :

Ell\k:doamopm,




* In the Preflight: Edit Profiles window, click onﬂl to create a new profile designate to

NRC.

Preflight: Edit Profile B

JE4 e Compliant with PDF/A (Draft)
+-5 Digital press (B/W)

H-5(- Digital press (color)

H-4- Magazine Ads

+-51~ Newspaper Ads

+-51+ NRC-10CFR1

H-51- PDF/X-1a:2001 compliant
t-4= PDF/X-1a:2003 compliant
H-510 PDF/X-3:2002 compliant
H-51+ PDF/X-3:2003 compliant
+-5~ Sheetfed offset (CMYK and spol
+-5~ Sheetfed offset (CMYK and spol
H-51- Sheetfed offset (CMYK) —
H-41- Web offset (cold set. CMYK anc
H-51- Web offset (cold set. CMYK. me
t-57- Web offset (heat set. CMYK anc
H-5- Web offset (heat set. CMYK)
-1 Compatibility with Acrobat 3

-85 Compatibility with Acrobat 4

-5 Compatibility with Acrobat 5

-5 Compatibility with Acrobat &

-5 Document generates more than four p
-5 Document generates more than one p
H-4f& Document generates more than two pl

o O O O O e OO e O YO e O YO = O O O = T O YO = OO == OO WO == O O = O = = B =1

H-(5 List =85% black objects set to knock ¢+

General

Campliant with FOELS [Draft)

[ ame; Compliant with PDF/A (Draft)

@

Furpose:

Suthar:

Erriail: |

¥ | Prafileiiz a favarite

[~ Protect Profile with password

{® Locked |.|

s] 2l X wf A

[ ox 1]

Cancel Save

* Give the new profile a name (e.g., “NRC-10CFR1").

Preflight: Edit Profile [ |

H-&f% List images below 250 ppi -

H-&f% List images not CMYK

H-&f& List images not CMYK ar spot

H-&f& List JPEG compressed images

H-&f% List non BAW objects

H-&f% List non CMYK objects

H-&f& List objects using ICC/Lab/calibrated «

H-&f5 List smocth shades

H-&f& List spat color objects

H-&f5 List teat using Courier inside Trim/Blee

H-&f% List tead using non-embedded fonts

H-&f& List transparent objects

H-&f& List white objects set to overprint

+|-&f% PostScript 3 support required
NRC-10CFR1

----- Document

Fem WO =T O e O e N YO = O O = O = O = O == T =1

[

----- Rendering

----- PDF/% Compliance
----- Convert to PDF/X
----- Custom Checks

..... Summary

4

| 2 x| wf A

General NRC-10CFR1
Name: 10CFR1
Purpose: d
Authar: |kdn
Email: |
™ Profile is a favorite
™ Protect Profile with password
5 Unlocked|~|
oK I Cancel Save




» Edit the subcomponents as follows:

Document

el'l The PDF document requires at least

" Acrobat 4.0 (PDF 1.3)

~
Preflight: Edit Profile Gl alANF T

Frrm TR e DO = OO e YOO e DO = OO s OO e DO = OO e DO = OO = WO P DO = |
L LH

].
].
].
].

o

-aie List images below 250 ppi
“ato List images not CMYK

-gio List images not CMYK or spat

“alo List JPEG compressed images

-gta List non B/ objects

-5ia List non CMYK objects

-51a List objects using ICC/Lab/calibrated
-5fe List smooth shades

-5 List spot color objects

o List teast using Courier inside Trim./Blee
515 List text using non-embedded forts
-5 List transparent objects

-gio List white objects set to overprint
-41a PostSeript 3 support required

NRC-10CFR1
£ Document
@ Pages

3 Images

&

" Acrobat 6.0 (PDF 1.5)

General ) " Acrobat 7.0 (PDF 1.6} i il
(1 [NAC-10CFR |- ™he POF document s encrypted T
Fumpose: lel The PDF document is damaged and needs repair .]

Author:

= I—' lel higher than IC pizels perinch (ppi]

™ Profile is a favorite 3 |+ | lower than ISDD pixels per inch {ppi)

[ Protect Profile with passwo

Images
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Resolution of bitmap images is
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~gis Convert to POFAX
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lel Images are uncompressed
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NRC-10CFR1

xlvl Fort is not embedded
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The new Preflight profile is created and can be used later for testing. See section

6.4.




4.2.3 m Adobe Acrobat 8.0 Professional

Note: You can download and install a NRC created Adobe Preflight profile by following
instructions in question 8 of the FAQs section.

« Launch Adobe Acrobat 8.0 Professional.
* From the main menu, click on Advanced and select Preflight.

Adobe Acrobat Professional [=(o)x]
File Edit View Document Comments Forms Tools | Advanced Window Help
E’ Formsz - 3 Review & Comment ~

@ Create PDF = ,@ Combine Files » @ Exporl # Sian & Certify
(O = N NEEE R I B A0 security Settings... | ééIF'r‘

| ﬁ Security 4
Manage Trusted Identities. ..

-

Enable Usage Rights in Adobe Reader...

Print Production
Redaction

Document Processing
Web Capture
Accessibility

PDE Optimizer

Preflight

@Proﬁles '\&Resuhs | % Report 9 Comment]

Preflight profiles:

El-Acrobat/PDF version compatibility

----- B " Compatible with Acrabat 3
@& Compatible with Acrobat 4 \
----- 8 [ Compativi ith Acrcbat 5 + From the Preflight window, select a
""" @ E: Compatible with Acrobat & . H .
----- 1D T Compatibe with Acrobat 7 profile and click on Edit from the menu

[#-Digital printing b bar
#-Imported profiles

[#-PDF analysis

[+ DOE fivine

Purpose of the selected Prefiight profile:

Verifies whether the current document is compatible with Acrobat 3 and reparts errors _‘I
if features are used that are not supported in Acrobat 3,

™| Rum Preflight checks for visible layers anly:
™| Rum Preflight profile without applying fixups

I Ereflight only pages I 1 ko I 1 Execute |

ﬁ| PDF /¥ status: not avaiable (no document open)
ﬁ| PDF/A status: not available {no document open)




* In the Preflight: Edit Profiles window, click onﬂl to create a new profile designate to
NRC.

Preflight: Edit Profile

El"'ﬁ:\crohatfPDF versior ~| @ Locked v| Tame: ICc-mpatibIe with Acrobat 3 GEnEra
EI& Compatible

""" 3 Document

[=]

""" a Pages Purposer |verifies .

Suthor: I Acrobat 8

Ermnail: I

""’é—f—; Summary Graup; IAcrobat_-"PDF wversion compatibility d
[]--- i& Compatible w
[]---& Compatible w
[]---& Compatible w
I:I---g? Compatible w

+|-Digital printing
t-Imported profiles
+-PDF analysis
H-PDF fixups
+-PDF/A compliance
H-PDF/X compliance
-

[en T = e = R = = W =1

+-Prepress -
%ﬂ&ﬁﬂ

| oK I Cancel Save

* Give the new profile a name (e.g., “NRC-10CFR1").

Preflight: Edit Profile =)
./ POF/Y and PL2 5 Unlocked ,| Name: I General

al Corvert to PL
3 Custom ched

Purpose: ;I

2 summary
[]---57 Compatible w
[:l---j& Compatible w

[]---57 Compatible w ;I
[]---57 Compatible w

ElCustom profiles

Author: I kdn

.. Email: I
{2 Document
) Pages Group: ICustom profiles d
-} Images

{2 Colors

-4} Fonts

{0} Rendering

-~ PDF/% and PO
{4 Convert to P
() Custom chec—
1) Fixups

-1 Summary
[#-Digital printing
[+-Imported profiles _'I

2| ] ] x|

| OK. I Cancel Save




+ Edit the subcomponents as follows:

Preflight: Edit Profile

5----5) Convert to POFJY or POF/A 2
3 Custom checks

&/ Fixups

’"“é»}; Summary

i#d® 5 Compatible vith Acroat 4
EJ---E? Compatible with Acrobat 5
i#3® B Compstinle with Acronat &
EJ---E? Compatible with Acrobat 7
ElCustom profiles

= 0. [

""" Document
..... x Pages

..... 3 Images

O\

""é—f—; Summary
[#-Digital printing

#-Imported profiles
[*-PDF analysis -

/-

P Unlocked

el"l The PDF document uses feature
™ Acrobat 4.0 (PDF 1.3)
& Acrobat 5.0 (PDF 1.4)
" Acrobat 6.0 (PDF 1.5)
™ Acrobat 7.0 (PDF 1.6)

lel The POF document is encrypted +—

Jl‘l The PDF document is damaged &

/

W

Email: I

- | Page size is not I 0 Centimet]

within & kalerance of plusiminus I 0
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ezolution of color and gray scale images is

— 3

e Je T

xlvl lower than | 300

Resclution of bitmap images is

|| lower than | 300

Jl'l Images are uncompressed

&d|~| Images use lossy compression

JH Images use OPI

_)H higher than I 0 piels per inch (ppi

__)H higher than I 0 pixels per inch (ppi

pixels per inch {ppi)

pixels per inch {ppi)

4= 1 T Save

\ |

* Then click on

AN

|- | Font is not embedded

Jl*l Font is embedded

¥ a5 o subiset

£ complebely

The new Preflight profile is created and can be used later for testing. See section

6.4.



5.0 Conversion Information

5.1 Converting Microsoft (MS) Office Suite XP/2003 to PDF

5.1.1 = MS-Office Word 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up and

configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create an

Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further. Instructions to remove/delete sensitive/unwanted text can be found at

http.//adamswebsearch.nrc.gov/idmws/ViewDocByAccession.asp ?AccessionNumber=ML060760600.

Launch Microsoft Word (either on the desktop or from Start => Programs =
Microsoft Office => Microsoft Office Word 2003).

Verify that the Microsoft Word conversion settings match the profile you created in

Section 4.1 by going to the main menu and clicking on Adobe PDF => Change

Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other settings.
When you have configured and saved the Acrobat PDFMaker settings, start the
conversion process on page 53 of this section.

@ pocument1 - Microsoft Word _ O] x|
File Edit View Insert Format Tools Table ‘Window Help | Adobe PDF | Acrobat Comments X
DEHR S AV E BB - | & B3 dr 5 Convertto Adobe PDF B
- 5 H ®| Convert to Adobe POF and EMail
®| Convert to Adobe PDF and Send for Review
IZE ----- B Lo 108 q44 v 1ED ¢+ 1§ -+ 25D - -
| | Change Conversion Settings |
t
el
T
[z ==wd | i
Page 1 Sec 1 11 At 72pt ln 1 Col 1 REC TRK EXT OWR ~




The Acrobat PDFMaker window pops up.

g2 Acrobat PDFMaker

Settings | Security | word | Bookmarks |
- PDFMaker Settings

Conversion Settings:

Use these settings to create Adobe PDF documents suitable for reliable viewing =«
and printing of business documents. Created PDF documents can be opened with_~

I¥ view Adobe PDF result
I¥ Prompt for Adobe PDF file name

¥ Convert Document Information Advanced Settings ... I

r~ Application Settings
[~ Attach source file to Adobe PDF

¥ Add bookmarks to Adobe PDF

¥ add links to Adobe PDF

¥ Enable accessibility and reflow with Tagged PDF

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
r“ reserved. Adobe, the Adobe loge, Acrobat, the Acrobat logo, PostScript, and
Adob the PostScript logo are either registered trademarks or trademarks of Adobe
obe

Systems Incorporated in the United States andjor other countries.

Restore Defaults I oK I Cancel Help

Click on the Settings tab then in the Conversion Settings field of the PDFMaker
Settings section. Click on the dropdown arrow and select the profile you have
created (e.g., “NRC-10CFR1"). Uncheck Convert Document Information.

P& Acrobat PDFMaker [ <]
Settings ISer:untyl Word | Bockmarks |

~PDFMaker Settings
Conversion Settings:

Use these settings to create PDF Documents suitsble for compliance with 10CFR1,
Appendix A

¥ view Adobe PDF result

¥ prompt for Adobe POF file name
<! Convert Document Information > Advanced Settings ...
r~application Settings
I~ Attach source file to Adobe PDF
¥ Add bookmarks to Adobe PDF
¥ Add links to Adobe PDF
[¥ Enable accessibility and refiow with Tagged PDF

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights

’\‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and

Adob the PostScript logo are either registered trademarks or trademarks of Adobe
obe

Systems Incorporated in the United States and/or other countries.

Restore Defauits ok | canel | pep |

Click on the Word tab then uncheck Convert display comments to notes in
Adobe PDF.

i Acrobat PDFMaker
Settings I Security  Word |Bookn13rks I

Word Features

I~ Lonvert displayed comments to notes in Adobe PDI

¥ Convert cross-references and table of contents to links
¥ Convert footnote and endnote links
™ Enable advanced tagging

Leave the settings on the other tabs as they are. Click on .



To ensure that the fonts in the document will be embedded during the conversion

process, go to the main menu and click on Tools => Options.

Df Document1 - Microsoft Word M=l &3
File Edit WView Insert Format | Tools | Table Window Help AdobePDF  Acrobat Comments X
OEd FRF=Nr-Y ' é:,\) % speling and Grammar... F7 B Times MewRoman ~ 12 -~ | B U B

il Research... Alt+Click
2ol o e
Language »
EE ----- B T2 108 2,59----314----}5&:-----39&----_A|
| Shared Workspace...
—_— Letters and Mailings 3
Customize...
Options...
¥
[
+
@
¥

Elem=zwa | |

Page 1 Sec 1 11 At 72pt Ln 1  Col 1 REC TRK EXT OVR

Click on the Save tab in the Options window and check the Embed TrueType fonts
option. Enable Embed characters in use only and disable the Do not embed
common system fonts option. Click on to save the settings.

Options ﬂ
Security I Spelling & Grammar I Track Changes I
User Information I Compatibility I File Locations I
View I General I Edit I Print Save

Save options
I™ Always create backup copy
I Allow fast saves
# allow background saves
¥ Embed TrueType fonts
[V Embed characters in use only:
I~ Do not embed common system fonts

I~ Prompt for document properties
[~ Prompt to save Mormal template
[~ sawve data only for forms

W Embed linguistic data

I~ Make local copy of files stored on netwaork or removable drives
[ Save AutoRecover info every: 10

* Embed smart tags

r Saye smart tags as XML properties in Web pages

= minutes

Default format

Save Word files as: Word Document {*.doc)

I Disable features introduced after: Microsoft Word 97 j

Cancel

[ 1




Follow the steps below to convert a Microsoft Office Word 2003 document to PDF.

Launch Microsoft Word (either on the desktop or from Start => Programs =
Microsoft Office > Microsoft Office Word 2003).

Open a Word document by clicking on File > Open from the main menu.

i Microsoft Word =] E3
‘| File | Edit Wiew Insert Format Tools Table Window Help Adobe FDF  Acrobat Comments

E’I_T‘HEW--- |@ B | mread B e u B
o ]

File Search. ..

Permission

1P:\...\Guides_to_convert_word_to_pdf.pdf
2 P:\Work\MD_physical_security.pdf
3 P:\Work\EIE_Submittal_2.5_2.6.pdf

4 p:\starfire\HRMS_current.doc

Exit

Page Sec At Ln Col REC TRK EXT OWVR /d

The Open window appears.

Open HE
tockin:  [[& Deskton = @- 4@ X i - Toos~

My Documents: 5 ADAMSDistUH. exe
a My Computer @Exc&\ 2003

My Recent NR.C Network o GIMP 2
Documents L) Agency Wide icquﬁokg.exe
L2 Office Automation Applications nfoPaI:h 2003
@ Cl': Adobe Acrobat 7.0 Professional ! Noise Minja 2
Desktop &) Corel WordpPerfect 10 PuwerPoint 2003
Employee Express @Project 2003
\ @GroupWise 5 Pub\isher 2003
L-:) #8 HQ Service Reguest @0 shorteut to Snaglt32.exe
My Documents  |ig IDMDS Explorer gstart Sonique
T Rawshooter essentials 2005 EVNC Viewer
ei Report Daily Time EWord 2003
Access 2003

My Computer  KF acoustica MP3 €D Burner
File name: ~ 9 _
- Qpen
My Metwork I J Cancel
Places Files of type:  [all Files (=.%) =l |

Select the Microsoft Word document you want to convert to PDF and click on

Note: Remove all hyperlinks to other electronic files or Web sites unless the document includes
a disclaimer that the hyperlinks are either inoperable or are not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office Word 2003 to PDF file,
“Convert to Adobe PDF” and “Print to PDF”’.

5.1.1a “Convert to Adobe PDF’ method:

Note: if you are using an older version of Microsoft Word or Adobe Acrobat 5.0 or
older, please follow the instructions on page 56, “Print to PDF”.

From the main menu, click on Adobe PDF => Convert to Adobe PDF or click
onl=:
™

File JEdit wview Insert Format Tools Table Window Help | Adobe PDF | Acrobat Comments =
NEHR &S QA |V E | Ba@d 9 - & [|E El'@ Convert to Adobe PDF | E
JE e ! ML Convert to Adobe PDF and EMail
ﬁ Convert to Adobe PDF and Send for Review
[ e - ECTI 720 e 108 + + + ddd - - - 1ED - B1E - - - =
- : - : : - Change Conversion Settings ﬂ
ra
I +F]
: JARMS SOFTWARE INVENTORY
" PRODUCT VERSION VENDOR
'il"- Solaris 238 Sun Microsystems
- “Wohine hManager 32 Weritas
E‘ NetExpress COBOL 20 Merant
:- C/C++ 42 Sun Microsystems
g
- Netscape Commmmnicator 451 Netscape Comrmmunications
;? Netscape Enterprise Server 36 Netscape Comrmmunications
- Sybase 12.0.5 Svbase LI
N S
- SQR 13422 Brio °
- N — ==  ——=y &
= B[E| = 8 4| | i3
Page 1 Sec 1 1/3 At 72.7pt Ln 1  Col 1 REC TRK EXT oOvwR (G35 >

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .

Save Adobe PDF File As [ 2]

Savein: IL:‘)Starfire ;I o 7 CF G-

- TR current paf:

Desktop

My Documents

My Computer

.

NRC Network

File mame: IHRMS_current pdf j Save

Save as type: [POF files =] Cancel




A series of popup windows show the conversion status.
E2 Acrobat PDFMaker |

Searching...

ll l Cancel

Show Details

£ Acrobat PDFMaker

T

Creating PDF Tags ...
lllll Cancel
Show Details
E& Acrobat PDFMaker Ed |
Processing for Tag Information ... 9 % complete
] Cancel |
Show Details |
f8 Acrobat PDFMaker E1 |
Converting to Adobe POF ...

II I Cancel

Show Details

protng K|

Mow printing Page 2
Of 'HRMS_current.doc’ on the
Adobe PDF

Canicel

When the conversion process is completed, the Microsoft Office Word 2003
document is converted into a PDF document and Adobe Acrobat Professional

(or Adobe Acrobat Reader) may launch automatically with the new PDF
document.



5.1.1b

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are

not essential to the filing.

“Print to PDF’ method:

From the main menu, click on File = Print.

@ HRMS_current.doc - Microsoft Word =]
File | Edit View Insert Format Tools Table Window Help AdobePDF  Acrobat Comments x
J Mew g} j 4 Read B Times New Roman ~ 12 u B
&= open ctrl+0

G Close

[ BO » ¢+ 216 0 r o 352 JES o0 324 ooc 30 ¢ 3G -
& save ctrl+s  f . : : . : :

Save As
@y Save as Web Page...
$1  File Search...
Permission 3
Web Page Preview TWARE INVENTORY
L -
1 W Pogeseup.- VERSION VENDOR
N . . g Sun Microsystems
L4, Print Preyiew -
[= ernt... crl+p |2 Veritas
" Send To r |0 Merant
" 1 P:\starfire\HRMS_current.doc 2 Sun Microsystems
L 2P\ \Guides_to_convert_word_to_pdf.pdf 31 Netscape C rcations
a 3 P:\Work\MD_physical _security.pdf —
G Netzcape Comnmmications
4 P:\Work\EIE_Submittal_2.5_2.6.pdf
" ) BOS Sybase =
Exit - "
1 % 3422 Brio o
I F
I = =4 Moo
>l
13 At 72.7pt Ln 1 Col 1 REC TRK EXT OWR |G3K )

The Print window pops up. Verify that the printer name is set to Adobe PDF.

Print I E3
rPrinter
Mame: | & Adobe POF = Properties |
EihE Ide Find Printer. .. |
Type: Adobe PDF Converter
Where: My Documents ™ Print to file
Comment: ™ Manual duplex
rPage rangs rCopi
= All MNumber of copies: £
[ Current page " Selection
" Pages: 11 11 ¥ Collate
Enter page numbers andfor page ranges
separated by commas. For example, 1,3,5-12

Print what: IDocument

=

Print:

Options...

IAII pages in range

=l

rZoom

Pages per sheet:

I 1 page 'I
Scale to paper size: INo Scaling 'l

[ oc 1]

Cancel |

Click on ml to bring up the Adobe PDF Document Properties screen.




Click on the Adobe PDF Settings tab and change the following settings:

* Change the Default Settings to NRC-10CFR1 (the default profile created in
Section 4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.

&% Adobe PDF Document Properties EHE

Layout | Paper/Qualiy [/} Adobe PDF Settings |
—Adobe POF Conversion Settings

Usze these settings to create POF Documents suitable for compliance with 1T0CFR1, Appendix

(;) 1
Default Settings: [ =IRSEEE - Edit... |
Adobe PDF Security: INone j Edit... |
Adobe PDF Output Folder IF'rc.mpt for &dobe POF filename j Browsze... |
Adobe PDF Page Size: [Letter =] aw. |

v Wiew Adobe POF results

< Add Document Informatio
<| Do hot send forts ko “Adobe PDFT >

¥ Delete |og files for successful jobs

[~ Ask to Beplace existing PDF file

ok | Cancel |

Click on __* | The Print window reappears. Click on Ll to start the
conversion.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on E

Save Adobe PDF File As [2]
Save in: I =3 Starfire ﬂ €] 5 il

ZHRMS curent pdf.

File name: IHRMS_currervt pdf ﬂ Save I
Saveastype:  [PDFfies =l Cancel




The Creating Adobe PDF window shows the conversion status.

Creating Adobe PDF [_ O] |

Document N ame : I Microsoft Wiord - HRMS_current. doc j

— PDF Progress
Microzoft ‘word - HRRS_current. doc

FPOF Mame : HRKMS_curent. pdf
PDF Folder - F:%Starfire,

Sending Page : 3

When the conversion is completed, the Microsoft Office Word 2003 document
is converted to a PDF document and Adobe Acrobat Professional (or Adobe
Acrobat Reader) may launch automatically with the new PDF document.



5.1.2 m MS-Office Access 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up
and configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create
an Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Microsoft Access (either on the desktop or from Start > Programs =>
Microsoft Office = Microsoft Office Access 2003).

Verify that the Microsoft Access conversion settings are set to the profile you
created in Section 4.1 by going to the main menu and clicking on Adobe PDF =>
Change Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other
settings. When you have configured and saved the Acrobat PDFMaker settings, start
the conversion process on page 61 of this section.

Unlike other Microsoft Office applications, MS-Access has another option, Convert
Multiple Reports to Single PDF, which is not discussed in this guide.

Microsoft Access =]

© Fle Edit View Insert Tools Window Help | Adobe POF Type a question for help =
'@ ﬁ ! '@ Convert to Adobe PDF

M| Convert to Adobe PDF and EMail

DSEEHD SRV EBa@|9-

ﬁ Convert to Adobe FDF and Send for Review

ML Convert Multiple Reports to Single PDF

Change Conversion Settings

Ready UM L




The Acrobat PDFMaker window pops up.

Settings | security |

—~ PDFMaker Settings
Conversion Settngs: -
Use these settings to create Adobe PDF documents suitable for reliable viewing =
and printing of business documents. Created PDF documents can be opened with _x
¥ view Adobe PDF result
[+ Prompt for Adobe PDF file name
¥ Convert Document Information Advanced Settings ... I
— Application Settings
™ Attach source file to Adobe PDF
W Add bookmarks to Adobe PDF
5] Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/for other countries.

Restore Defaults | OK I Cancel Help

Under the Settings tab, in the Conversion Settings field of the PDFMaker
Settings section, click on the dropdown arrow and select the profile you have
created (e.g., “NRC-10CFR1"). Uncheck Convert Document Information.

ﬂ‘. Acrobat PDFMaker E

Settings ISecum:y I

— PDFMaker Settings
Conversion Settings: i

Use these settings to create PDF Documents suitable for compliance with 10CFR.1,
Appendix A

¥ view Adobe FDF result

¥ Prompt for Adobe PDF file name
<|_ Convert Document Information > Advanced Settings ...
— Application Settings

I~ attach source file to Adobe PDF
¥ add bookmarks to Adobe FDF

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States andfor other countries.

Restore Defaults | Ok I Cancel I Help

Leave the configurations on the Security tab as they are. Click on



Follow the steps below to convert a Microsoft Office Access 2003 database to PDF.

Launch Microsoft Access (either on the desktop or from Start > Programs =>
Microsoft Office = Microsoft Office Access 2003).

Open an Access database by going to the main menu and clicking on File => Open.

Microsoft Access M=l =
| Fle | Edit Wiew Insert Tools Window Help Adobe PDF Type a question for help  ~
)] Mew... Ctrl+

E - Ctrl+0 . .
o= |8 @ e s Sa- e

Send To

1 Morthwind. mdb
2 W \RDSB_Tracking.mdb

3 \Documents and Settingsikdn), .. \db1.mdb

Exit

Ready UM S

The Open window appears.

Lookin: | SAMPLES =l @-0 @ X Ci - Tods~
- | INFOPATH
LJ E orthwind.mdb
My Recent
Documents
Desktop
My Documents
My Computer
File pame: \ - Open o
My Netwark I H g o
Places Files of type: IMicmsnFt Office Actess (%.mdb; . adp; *. mda; *.mde; %.ade v | |— Cancel

Select the Microsoft Access database you want to convert to PDF and click on
Open




The Database window appears.

B Microsoft Access |_ (O] x|
: Fle Edit View Insert Took Window Help Adobe PDF Type a question for help -

NDEEHR SRV ERB| 955 e |f | =FA- e
i:‘:n Northwind : Database (Access 2000 file format)

[Fopen & Desion Tnew | K | 2o T

5
&

Create table in Design view

Create table by using wizard
Create table by entering data

EUgtE o

Categories

Customers

EFmployees

Pages Order Details

Macros. Orders
Products

Modules Shippers

[ [ oo

Groups
%1 Favorites

Suppliers

Ready NUM i

Convert existing tables from the Tables tab in the Objects section, or convert a
report to PDF by clicking on the Report tab and double-clicking on a report, (as in
the screen below). Do the same for Forms if you want to convert a form to PDF.

Microsoft Access =]
© Fle Edit View Insert Tools Window Help Adobe PDF Type & question for help -
mmEl

NDEEHV GQV 4RI 5% FA- e F=E4-1@
[ Northwind : Database (Access 2000 file format)
& Preview B Desion gatew | X |2 T+ |E

Objects Sales Totals by Amount
Tables Summary of Sales by Quarter

. Summary of Sales by Year
Queries " "
Forms:

Reports
Pages

Macros

Modules

&ﬁm?;hﬂtmu

Groups

& Favorites

Ready MM 4

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office Access 2003 to PDF file,
“Convert to Adobe PDF” and “Print to PDF”.

5.1.2a

“Convert to Adobe PDF’ method:

Note: if you are using an older version of Microsoft Office Access or Adobe

Acrobat 5.0 or older, please follow the instructions on page 65, “Print to PDF”.

From the main menu, click on Adobe PDF =>Convert to Adobe PDF or click

Edit

ﬁ!

View Insert Format Records

Tools

‘- HdB DAV Sl R3]k

Order 1D

Product

10248
10249 Tofu

10249

10250
10250
10251
10251
10251
10252
10252
10252
10253
10253
10253
10254
10254

AnNNCA

Record:

Queso Cabrales
Singaporean Hokkien Fried Mee
Mozzarella di Giovanni

Manjimup Dried Apples

10250 Jack's New England Clam Chowder

Manjimup Dried Apples

Louisiana Fiery Hot Pepper Sauce
Gustafs Knackebrid

Raviali Angelo

Louisiana Fiery Hot Pepper Sauce
Sir Rodney's Marmalade

Geitost

Camembert Pierrot

Gorgonzola Telino

Chartreuse verte

Mazxilaku

Guarana Fantastica

Paté chinois

| calife Tofs

|<|<|| 1 >|>||He|of2155

Same as Order ID in Orders table.

Window Help | Adobe PDF Type a question for help - X
|7 Convert to Adobe PDF |
®L| Convert to Adobe PDF and EMail
| Uit Price | Qua ﬁ Convert to Adobe PDF and Send for Review ]
$14.00 @ Convert Multiple Repaorts to Single PDF
$9.80 Change Conversion Settings
534 80
5158.60 9
542.40 40
57.70 10
542 40 35
516.80 15
$16.80 6
51560 15
516.80 20
56480 40
52.00 25
52720 40
51000 20
514 40 42
$16.00 40
$3.60 15
519.20 21

To AN

The Save Adobe PDF File As window
the File Name field, then click on

Save Adobe PDF File As

Savein: || Starfie

Recent

@.

Desktop

4

My Documents

e
or
My Computer
-
NRC Network

21 x]
EH Q& -
TUHRMS_current. pdf
File pame: [HRMS _cument oot =] Save
Save as type: IPDFflIes =1 Cancsl ],
v

pops up. Enter the name you want in
i-ﬁave .



A series of popup windows show the conversion status.

f& Acrobat PDFMaker |

Converting to Adobe PDF..

ENNENNRNNNER Cancel

Show Details

Werotng ———— GIE]

Mow printing page 15 of
'Order Details' to the

Adobe POF on My Documents\*, pdf

f8 Acrobat PDFMaker E1 |

Completing POF file conversion, ..

Cancel

Show Details

When the conversion is completed, the Microsoft Office Access 2003 database
(tables, report, forms, queries, etc.) is converted to a PDF document and
Adobe Acrobat Professional (or Adobe Acrobat Reader) may launch
automatically with the new PDF document.



5.1.2b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are not
essential to the filing.

From the main menu, click on File = Print.

Microsoft Access - [Order Details : Table] =]
: | File | Edit WView Insert Format Records Tools Window Help  Adobe POF Type aquestion forhelp - _ & X
Ly 1 New... Cirl+
3 O Cirl+0 =
gl e AR IR RAL A =E= Rk

[Tl Get External Data * ([ Unit Price | Quantity [ Discount

L Close $14.00 12 0%

||| save Ctrl45 59.80 10 0%

| . $34.80 5 0%

= $18.60 9 0%

| Back Up Database... $42.40 A0

- Export... §7.70 10

L[| File Search... $42.40 35 15%

- $16.80 15 15%

RassEsaie $16.80 6

: [& Print Preview $15.60 15

| [ [ ent... Cirl+p $16.80 20

$64.80 40

| Send To 3 $2.00 25

: Database Properties §27 20 40

- 1 Morthwind.mdb $10.00 20

$14.40 42

— 2 W:\RDSB_Tracking.mdb $16.00 40

T 3 \Documents and Settings'kdn),. .. \db1.mdb 5360 15 15%

- Exit $19.20 21 15%

— Tooan 734 i
Record: 14| 4 || 1 _» | v |p#| of 2155
Same as Order ID in Orders table, MUM s

The Print window pops up. Verify that the Printer Name is set to Adobe PDF
in the dropdown menu.

Print 21
rPrinter
MNane: | & Adobe DR | Properties
'?':;JS i I;‘!libe PDF Converter ml
Where: My Documents: I~ Print to file
Comment: ™ Manual duplex
rPage rangs Copi
o Al Number of copies:
" Current page ¢ Selection
" Pages: 11 11 W Collate
Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12

Print what: IDocument j Zoom

_ Pages sheet: |1 l
Print: IAII pages in range j POSS PEr == =
Scale to paper size: INo Scaling 'l

Options... QK Cancel
_options... | I I

Click on ﬂl to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

» Change the Default Settings to NRC-10CFR1 ( the default profile created in
Section 4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document

Information.
This will ensure that the fonts are embedded and exclude document’s

Properties information.

%" Adobe PDF Document Properties EHE3

Layout I Paper/Quality ﬂ' Adobe PDF Settings |
—Adobe PDF Conversion Settings
Uze theze zettings bo create PDF Documents suitable for compliance with 10CFRT, &ppendis

Default Settings: =] in==4| - Edit... I

Adobe PDF Security: INone LI Edit... I
Adobe PDF Output Folder IF'rompt for &dobe POF filename LI Browse. . I
Adobe PDF Page Size: ILetter LI Add... I

I~ Wiew Adobe PDF results

rfdd Dacurment lnfarmatial
Do not send fonts to "Adobe PD

[V Delete log files for successiul jobs

[T Ask to Beplace existing POF file

Clickon __%_|. The Print window reappears. Click on to start the

conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .

Save Adobe PDF File As

Savein I@Starfire Bl Q¢

.,'_&KHRMS_mrrent. pdf|

Save I
Cancel

File name: IHF( MS_cument pdf

Ll L]

Save astype IPDFNes




The Creating Adobe PDF window shows the conversion status.

Creating Adobe PDF M= |

Docurnent Mare : I Order Dietails j

—POF Progress
Order Details

PDF Mame : Order Details. pdf
POF Folder - C:%Frogram Files\OFFICET 145 4MPLE S

When the conversion is completed, the Microsoft Office Access 2003 database
(tables, report, forms or queries, etc.) is converted to a PDF document and
Adobe Acrobat Professional (or Adobe Acrobat Reader) may launch
automatically with the new PDF document.



5.1.3 = MS-Office Excel 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up
and configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create
an Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Microsoft Excel (either on the desktop or from Start => Programs =
Microsoft Office => Microsoft Office Excel 2003).

Verify that the Microsoft Excel conversion settings match the profile you created in
Section 4.1 by going to the main menu and clicking on Adobe PDF => Change
Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other
settings. When you have configured and saved the Acrobat PDFMaker settings, start
the conversion process on page 71 of this section.

Like Microsoft Access, Microsoft Excel gives you another option, Convert Entire
Workbook, which is not discussed in this guidance document.

£ Microsoft Excel =]
© File Edit View Insert Format Tools Data  Window Help | Adobe PDF Type a question for help -
Hr=1 B | ,” .|| B I U|=E= L Convert to Adobe PDF !
.@ ﬁ ! Convert to Adobe POF and EMail

- 3 ﬁ Convert to Adobe PDF and Send for Review

Convert Entire Workbook

Change Conversion Settings

Ready MNUM v




The Acrobat PDFMaker window pops up.

Settings | Security |

~PDFMaker Settings
Conversion Settings: =

Use these settings to create Adobe PDF documents suitable for reliable viewing _=
and printing of business documents. Created PDF documents can be opened with_~

¥ view Adobe PDF result
¥ Prompt for Adobe PDF file name
¥ Convert Document Information STt BT |

 Application Settings
I™ Attach source file to Adobe PDF

¥ Add bookmarks to Adobe PDF

¥ Add links to Adobe POF

¥ Enable accessibility and reflow with Tagged FDF
|_ Convert comments to notes

I~ Fit Worksheet to a single page

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/for other countries.

Restore Defaults | QK I Cancel Help

Under the Settings tab, in the Conversion Settings field of the PDFMaker
Settings section, click on the dropdown arrow and select the profile you have
created (i.e., “NRC-10CFR1"). Uncheck Convert Document Information.

i Acrobat PDFMaker

Settings | Security |

~PDFMaker Settings
Conversion Settings: L1

Use these settings to create PDF Documents suitable for compliance with 10CFR1,
Appendix A

v view Adobe POF result

¥ Prompt for Adobe PDF file name

Convert Document Information Advanced Settings ...

~Application Settings
[~ Attach source file to Adobe PDF

¥ Add bookmarks to Adobe PDF

IV Add links to Adobe PDF

¥ Enable accessibility and reflow with Tagged PDF
I Convert comments to notes

™ Fit Worksheet to a single page

reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/or other countries.

’ ‘ ® Copyright @ 1987-2004 Adobe Systems Incorporated and its licensors. All rights

Restore Defaults | OK Cancel | Help I
z =

Leave the configurations under the Security tab as they are. Click on



Note: If you want to convert the entire workbook, follow the instructions below.
Otherwise skip to page 89.

From the main menu, click on Adobe PDF and select Convert Entire Workbook.

B3 Microsoft Excel - Book2 =]
@_] File Edit Wew Insert Format Tools Data Window Help W‘ Type a question forhelp = _ @
=" B Arial 10 v | B I U ‘@ Convert to Adobe PDF h
@ @ = H @ Convert to Adobe PDF and EMail

Al

- A | Convert to Adobe PDF and Send for Review

A | B | ¢ | b | E

-

| Convert Entire Workbook |

Change Conversion Settings

alalala
B2

-
m

[RE V] N Y i Y
— | oW o~ T

-
W 4 » w]\Sheet1 { sheetd fSheets Kl | L”J
Ready NUM S

Click on Adobe PDF from the main menu again. There is a check mark (v/) in front
of the Convert Entire Workbook option.

T Microsoft Excel - Book2 =] 3
@_] Ele Edit View Insert Format Tools Data Window Help | Adobe PDF | T 2
2 Convertto Adobe PDF h

=" | BAriaI -0 - B I U
@ @ = l @ Convert to Adobe PDF and EMail
Al

- A | Convert to Adobe POF and Send for Review

A | B | ¢ | b | E

-

M Convert Entire Workbook

Change Conversion Settings

) R )Y R Y Y Y

: -
M 4 » M]\Sheetl {Sheet? [ Sheet3 K| | LlH
Ready HUM &




Follow the steps below to convert a Microsoft Office Excel 2003 spreadsheet to PDF.

Launch Microsoft Excel (either on the desktop or from Start => Programs => Microsoft
Office => Microsoft Office Excel 2003).

Open an Excel spreadsheet by going to the main menu and clicking on File = Open.

E Microsoft Excel M=l E3
‘| Bile | Edit View Insert Format Tools Data  Window Help  Adobe PDF Type a guestion for help -
{0 New.. CiN E==FH|$ % » = »-A-

File Search...

Permission

Send To

1 Capture Scanner Matrix.xls

2 \Program Files\OFFICE11\ibraryyan. .. \PROCDB.XLA
3 Pi\starfire\CFO 1uid. xls

Exit

Ready NUM S
The Open window appears.
Open & 3
Locki: [ Sample Documents =l @ -3 @ X [y EF - Took~
= Capture Scanner Matrix.xls
LJ | Towers Perrin Success Story.him
My Recent
Documents
Desktop
\
My Documents:
My Computer
File name: - -
My Metwork I‘ _I L= | I
Places Fiies of fype: [all Microsoft Office Excel Files (%1% =.xds; =.xdit; =htm; * = Cancel l
2

Select the Microsoft Excel spreadsheet you want to convert to PDF and click on

Note: Remove all hyperlinks to other electronic files or Web sites unless the

document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office Excel 2003 to PDF file,
“Convert to Adobe PDF” and “Print to PDF".

5.1.3a

“Convert to Adobe PDF’ method:

Note: If you are using an older version of Microsoft Office Excel or Adobe

Acrobat 5.0 or older, please follow the instructions on page 74, “Print to PDF”.

From the main menu, click on Adobe PDF =>Convert to Adobe PDF or click

Edit  View

Insert

Format Tools Data Window Help | Adobe PDF Type a question for help - o B X

-0 - B 7 UO|E=E=

|‘@ Convert to Adobe PDF |

@ Convert to Adobe PDF and EMail

e 3 |
- ~ | Convertto Adobe PDF and Send for Review
A B C D E Convert Entire Workbook
Change Conversion Settings
Auto- (L
Feed/Flat 200, 1
77 [15410 Kofax 9275 Configurable Low Simplex 22 bed 300400 |:C
78 | Sharp
Adaptec
JX-300, 320, PT Win 1542 1S4
79 | 325 a5 SCSl Configurable| Personal [Simplex
Adaptec
PT Win 1542 1SA 29ms/ A-Size,
80 |JX-450 a5 SCSl Configurable| Personal [Simplex line color | Flatbed 200
Adaptec
PT Win 1542 1S4
81 [JX-610 95 SCsl Configurable| Personal [Simplex J
82
M 4 » M  Capture Supported Scanners 3, Capture non-supported Sca | A | | LIJ_‘

Ready

MUM e

The Save Adobe PDF File As window iops up. Enter the name you want in

the File Name field, then click on| Sav

Save Adobe PDF File As HE
Save in: I I Sample Documents ;I €] ? il EI'
=% background.pdf
™% Capture Brochure.pdf
I IDMCompPaper.pdf
File name = Save
Save as type PDF files = Eance




A series of popup windows show the conversion status.
B Acrobat PDFMaker |

Finding Page Breaks ...

’“ Cancel |
Show Details |

& Acrobat PDFMaker E3 ||| 2 Acrobat PDFMaker %
Saving POF Qutput Converting to Adobe POF.,

Cancel

| Cancel |
Show Details | Show Details |

Printing E |
Mow printing
'Capture Scanner Matrix,uls' on the
Adobe PDF on MNe02:

& Acrobat PDFMaker |

Creating Tags for Page 3 ...

Show Details |

When the conversion is completed, the Microsoft Office Excel 2003
spreadsheet is converted to a PDF document and Adobe Acrobat Professional

(or Adobe Acrobat Reader) may launch automatically with the new PDF
document.



5.1.3b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.

@_]EiT‘ Edit Wiew Insert Format Tools Data Window Help Adobe PDF Type & for help
= 1 Mew... Ctrl+N ===% % »
- 5 Open... Ctrl+0
B Close
: e save cl+s  |E F G H Zl'
LR e B-Size, .
/gy Save as Web Page... Auto- (L
| 77| == ow  |simplex 22 Fe?agglat 30200.560 :1c
Permission 3
ﬁ Web Page Preview
Page Setup...
Print Area 3
| 79 | 4 Print Preview Bonal |Simplex
ElE Ctrl+F
Send To 4 29ms/ | A-Size,
ﬂ 1 Capture Scanner Matrix. xls sonal [Simplex line color | Flatbed 300
2 \Program Files\OFFICE 11\Library\an...\PROCDE. XLA
81 3 P:\starfire\CFO uid. xls sonal [Simplex
; Exit . J
| v | -
14 4 » M|} Capture non-supported Scanners / JLI | LIJ_I
Ready NUM v

The Print window pops up. Verify that the printer name is set to Adobe PDF
on the dropdown menu.

Print H

Printer

Name: IQS Adobe PDF j Properties. .. |
Status: Idle e —
Type: Adobe PDF Converter w

Where: My Documents
Comment:

™ Print to file

rPrint range opies

Al Mumber of copies: lﬁ
" Page(s) Erom:l 5‘ To: I 5‘

rPrint what ﬂg ﬂg ¥ Colate
 selection " Entire workbook B

% Active sheet(s)  List

Preview | 0K I Cancel

Click on _ frapertes | to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

* Change Default Settings to NRC-10CFR1 ( the default profile created in Section
4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.

&% Adobe PDF Document Properties

Layout I Paper/Quality ﬂ' Adobe PDF Settings
—Adobe PDF Converzion Settings

Uze these settings ko create PDF Documents suitable far compliance with T0CFR1 ., Appendis

QA

Default Settings: [{={sln=] - Edit... I
Adobe PDF Securiy: |Nons =] Edt. |
Adobe PDF Dutput Folder IF'mmpt for Adobe PDF filename LI Browse... I
Adobe PDF Page Size: [Letter = add |

v iew Adobe PDF results

Add Document Informatio

Da hot zend fonts to “Adobe PD

W Delete log files for successiul jobs

[T Ask to Beplace existing POF file

QK I Cancel

Click on LI The Print window reappears. Click on to start the

conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on :

Save PDF File As [=
Save in: I =) My Documents j = = E-
|- Corel User Files
|-)My eBooks
I My Music
{2y My Pictures
File name: :a ture Scanner Matrix.pdf] j m
Save as type IPDFfiIEs [~.FOF) LI Cancel |
P




The Creating Adobe PDF window appears to show the conversion status.

Creating Adobe PDF I =] |
Document Mame : I Capture Scanner b atris xls j
—POF Progress

Building fant table. .

PDF Mame : Capture Scanner b atris. pdf
PDF Folder: C:\

Sending Page : 1

When the conversion is completed, the Microsoft Office Excel 2003
spreadsheet is converted to a PDF document and Adobe Acrobat Professional

(or Adobe Acrobat Reader) may launch automatically with the new PDF
document.



5.1.4 m MS-Office PowerPoint 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up
and configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create
an Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Microsoft PowerPoint (either on the desktop or from Start ©> Programs =
Microsoft Office > Microsoft Office PowerPoint 2003).

Verify that the Microsoft Powerpoint conversion settings match the profile you
created in Section 4.1 by going to the main menu and clicking on Adobe PDF =>

Change Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other
settings. When you have configured and saved the Acrobat PDFMaker settings, start

the conversion process on page 80 of this section.

E Microsoft PowerPoint - [Presentation2] =10l x|
5 File Edit Wew Insert Format Tools Slide Show Window Help | Adobe PDF
0 B  Arial -8 -|B I U | | $= iz | '@ Convert to Adobe PDF

: .@ @ ﬁ @ Convert to Adobe PDF and EMail

ﬁ Convert to Adobe PDF and Send for Review

Chal'qe Conversion Settings

...................................................................................

:DLEW'|AHt°5hBIJES' NNOOMEAdEE -Z2-A-=S=2 @ i!
Slide 10f 1 Default Design Y




The Acrobat PDFMaker window pops up.

Settings | security |

~PDFMaker Settings
Conversin Settings: =

Use these settings to create Adobe PDF documents suitable for reliable viewing =
and printing of business documents. Created PDF documents can be opened with_~

¥ wiew Adobe PDF result

¥ Prompt for Adobe PDF file name |

¥ Convert Document Information Advanced Settings ...

— Application Settings
[~ Attach source file to Adobe PDF

¥ Add bookmarks to Adobe PDF

¥ Add links to Adobe PDF

¥ Enable accessibility and reflow with Tagged PDF
¥ Save slide transitions in Adobe PDF

I~ Save animations in Adobe PDF

¥ cConvert Multmedia to PDF Multimedia

™ Convert hidden slides to PDF pages

¥ PDF layout based on PowerPaint printer settings

® Copyright © 1957-2004 Adobe Systems Incorporated and its licensors. All rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States andjor other countries.

Restore Defaults | oK I Cancel Help

Under the Settings tab, in the Conversion Settings field of the PDFMaker
Settings section, click on the dropdown arrow and select the profile you have
created (e.g., “NRC-10CFR1"). Uncheck Convert Document Information.

B Acrobat PDFMaker

Settings | Security |

~PDFMaker Settings
Conversion Settings:

@ Use these settings to create PDF Documents suitable for compliance with 10CFR1,

Appendix A

¥ view Adobe PDF result
W Prompt PDF file name

Convert Document Information Advanced Settings ...

 Application Settings
I~ Attach source file to Adobe PDF

¥ Add bookmarks to Adobe PDF

¥ Add links to Adobe PDF

¥ Enable accessibility and reflow with Tagged PDF
¥ Save slide transitions in Adobe PDF

™ save animations in Adobe PDF

¥ Convert Multimedia to PDF Multimedia

[™ Convert hidden slides to POF pages

¥ PDF layout based on PowerPaint printer settings

@ Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
"‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/or other countries,

Restore Defaults | OK I Cancel | Help

Leave the configurations on the Security tab as they are. Click on



To ensure that the fonts in the document will be embedded during the conversion
process, go to the main menu and click on Tools => Options.

& Microsoft PowerPoint - [Presentation1] [_ O] x|
@ File Edit WView Insert Format | Tools | Slide Show Window Help Adobe PDF Type a question for help » X
‘N ! { arial -8 -| |V soeling. F7 |i2 | A" o7 |35 55| A - | o Desion “1New Side B
@ @ ﬁ ﬁ Research... Alt+Click

Cnline Collaboration »
Customize...

¥

Click to add title

Click to add subtitle

o [l auoshapes N N OO A BEIS-L-A-===adf

Slide 1 of 1 Default Design 7

Click on the Save tab window and check the Embed TrueType fonts option. Check
Embed characters in use only and disable the Embed all characters option (to
save space). Uncheck Allow fast saves option. Click on[_o | to save the
settings.

You can change the Default file location if desire.

Dptions El
View | General I Edit I Print
Save I Security I Spelling and Style
Save options

I~ Allow fast saves
[~ Prompt for file properties
v Save AutoRecover info every |10 = minutes
[¥ Convert charts when saving as previous version
Save PowerPoint files as:
IP‘owerP‘oint Presentation LI

Default file location:
IC:‘I.Documents and Settings'kdnMy Documentst,

Font options for current document only
¥ Embed TrueType fonts
{* Embed characters in use only {(best for reducing file size):
~ Embed all characters {best for editing by others)

oK I Cancel




Follow the steps below to convert a Microsoft Office PowerPoint presentation to PDF.

Launch Microsoft PowerPoint (either on the desktop or from Start ©> Programs =
Microsoft Office = Microsoft Office PowerPoint 2003).

Open a PowerPoint presentation by going to the main menu and clicking on File = Open.

Format Tools

(R File | Edit  View Insert
P New... Cirl+
Ehj Qpen... cul+o |

Close

= Save

Save As...

Ctrl+5

|y Saveas Web Page...

Permission

Package for CD...

Page Setup...
& Print Preview

= Print...
Send To

Exit

Slide Show
- |B 7 U|E]=|:= = | A= = | =¥ 0esion 7 New Side

Window Help Adobe PDF

X

EDLaw'|Agm5hapes' N OO A 4::3 E] & | &vgvé'= B
Slide 10f 1

Default Design

The Open window appears.

Open
Look jn: | @-3 @ X i 3 - Tooks~
“ Name = -
*,} 1) .RWSettings
My Recent I)ADAMS
Documents C)Archive
= [ Converted
@ Sidata
Deskton IC)Documents and Settings
[C)Drivers —
[Zhhomes
| ) INFORMS
My Documents | [Z51S5C
IC)LDClient
Camail
: IMSCCache
My Computer CmssqL -
0 s | of
1 File pame: -
My Network. . I j B
Places Files of type: IAII PowerPoint Presentations (*.ppt; ®.pps; =.pot; = him; ‘.Iﬂ ‘ Cancel

Select the Microsoft PowerPoint presentation you want to convert to PDF and

click on

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are

not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office PowerPoint 2003 to PDF
file, “Convert to Adobe PDF” and “Print to PDF”.

5.1.4a “Convert to Adobe PDF’ method:

Note: If you are using an older version of Microsoft Office PowerPoint or
Adobe Acrobat 5.0 or older, please follow the instructions on page 83, “Print to
PDF’.

From the main menu, click on Adobe PDF => Convert to Adobe PDF or click

B r licrossft PowerPoint - [QUIKANIM.PPT]

;e Edit View Insert Format Tools Slide Show Window Help | Adobe PDF Type a question for help  + X
- 18 v|BIH|§§|§EEE||‘@wmm“ |

®L| Convert to Adobe PDF and EMail

2| Convert to Adobe PDF and Send for Review

Change Conversion Settings

No Animation

No Animation

EDLaw'|Agt05hapes' N2OOHEdD S E S-Z-A-==2 @ ﬁ!
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The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .
Save Adobe PDF File As [ 7] <]

Savein: [ Starfie =l @ 2 2 E-
™ [TEHRMS_current pof]

Recent

Desktap

My Documents
-
o

My Computer

-
NRC Network

File pame: [HRMS _cument.odf = Save
Save as type: [POFfies | Cancel




A series of popup windows show the conversion status.
E2 Acrobat PDFMaker |

Mapping Transitions ...

lﬁ Cancel

Show Details

£ Acrobat PDFMaker E |

Converting to Adobe POF ...

II. Cancel

Show Details

f& Acrobat PDFMaker |

Processing for Tag Information ... 63 ...

..l. Cancel

Show Details

When the conversion is completed, the Microsoft Office PowerPoint 2003
presentation is converted to a PDF document and Adobe Acrobat Professional

(or Adobe Acrobat Reader) may launch automatically with the new PDF
document.



5.1.4b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.
B Microsoft PowerPoint - [QUIKANIM.PPT] [_ (O] x|

Edit Vew Insert Format Tools Slide Show  Window Help Adobe PDF x
S mew.. Ctrl+N I U |§ | = = | A" | £= = | =¢Design =] New Slide B
E E Open... Ctrl+0

Close

Save
Save As...

Save as Web Page...

Permission

Package for CD...

Page Setup...

No Animation

Print Preview

Print...

Send To

No Animation

1,..11033\QUIKANIM.PPT
2\...11033\PROTTPLM.PPT
3\...\1033\PROTTPLV.PPT
4\...\Templates\powerpnt.ppt
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The Print window pops up. Verify that the printer name is set to Adobe PDF
on the dropdown menu.

Print I B3
Printer
Mame: Iu-’ Adobe PDFE LI Properties |
Status: Idie Find Printer. .. |
Type: Adobe PDF Converter
Where: My Documents
Comment: ™ Print to file
Printrange Copies
= i " Currentslide € Selection Number of copies:
€ custom stiow: | =1 1 =
 Sides: [ !'E 1;!
Enter slide numbers andjor slide ranges. For example,
1,3,5-12
¥ collate
Print what: Handouts
ISI'dES j' Slides per page: |6 vl % %
Color fgrayscale: Order: % Horizontal € Yertical =
Colar -
T Scale to fit paper I~ Frint hidden slides
™ Frame slides
™| Print comments and ink markup
Preview | oK I Cancel

Click on Ml to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

4.1).

Information.
This will ensure that the fonts are emb
Properties information.

&" Adobe PDF Document Properties

Layout | Paper/Quality [} Adobe PDF Settings |

Change Default Settings to NRC-10CFR1 (the default profile created in Section

Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document

edded and exclude document’s

[ 7] %]

—aAdobe PDF Conversion S etting:

Llze thesze zettings to create PDF Documents

(;)A

Diefaulk Settingz: [{EsTRn=y|

suitable for compliance with 10CFR1, Appendix

Edit... |

Adobe POF Security: INone

| Edt. |

Adobe PDF Output Folder IPrompt for Adobe

FDF filenarne

j Browse... |

Adobe PDF Page Size: ILetter
v “iew &dobe FDF results

Add Document Information

< Do not zend fonts to “Adobe PDF"

¥ Delete log files for successiul jobs

[ &sk to Replace existing PDF file

=] Add... |

ox |

Cancel |

Click on Lland the Print window reappears. Click on to start the

conversion process.

The Save Adobe PDF File As window po
the File Name field, then click on E

Save Adobe PDF File As

ps up. Enter the name you want in

Savein: I 15 Starfire

[ 21=]
G2 eE:
',_tKHRMS_current.pdff
File name [HRMS _cument pdt =l Save |
Save astype |POF fies =l Cancel
%




The Creating Adobe PDF window appears to show the conversion status.

Creating Adobe PDF M= |
Dacument Mame : IMil:n:us':nft FowerPaint - QUIKANIM.PPT j
—POF Progress

Creating Fage 2... QUIKAMIM . pdf

FOF Mame . QUIFRAMIM. pdf
POF Folder: b

Sardling Pepa 1 o :

When the conversion is completed, the Microsoft Office PowerPoint 2003
presentation is converted to a PDF document and Adobe Acrobat Professional

(or Adobe Acrobat Reader) may launch automatically with the new PDF
document.



5.1.5 = MS-Office Project 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up
and configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create
an Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before

proceeding any further.

Launch Microsoft Project (either on the desktop or from Start => Programs =
Microsoft Office > Microsoft Office Project 2003).

Verify that the Microsoft Project conversion settings match the profile you created in
Section 4.1 by going to the main menu and clicking on Adobe PDF => Change

Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other
settings. When you have configured and saved the Acrobat PDFMaker settings, start

the conversion process on page 88 of this section.

[ Microsoft Project - Project1

File Edit View Insert Format Tools Project Collaborate  Window  Help

Adabe PDF Type & question fi

M=l E3

orhelp » @ X

HEH S5 ® B4 @ E & % = gh"| Convertto Adobe PDF

fE| ~ | Resources =~ | Track - | Report -H
mzsfl

@ Convert to Adobe PDF and EMail
| Convert to Adobe PDF and Send for Review

| Change Conversion Settings |

(i } Tazk Name Duration 5 Ir17,'05 Apr24, 05 May 01, '05 May 08, '05 -
MITIW[T[F[S[S[M[T[W][T[F[s|S[M]TW][T[F[S]S[M]T[W]T]F

b

! Ml M

| Ready

BT |caPs [NuM

[scrL ([owr] 4




The Acrobat PDFMaker window pops up.

Settings | Security |

~PDFMaker Settings
Cenversien Settings: i

Use these settings to create Adobe PDF documents suitable for reliable viewing _+
and printing of business documents. Created PDF documents can be opened with_~

W view Adobe PDF result

¥ Brompt for Adobe PDF file name

¥ Convert Document Information AT R |

 Application Settings
I~ Attach source file to Adobe PDF

® Copyright € 1987-2004 Adobe Systems Incorporated and its licensors, All rights
'&‘ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks ar trademarks of Adobe
Adobe Systems Incorporated in the United States andfor other countries.

Restore Defaults | OK I Cancel Help

Under the Settings tab, for the Conversion Settings field of the PDFMaker
Settings section, click on the dropdown arrow and select the profile you have
created (e.g., “NRC-10CFR1"). Uncheck Convert Document Information.

#5 Acrobat PDFMaker B3

Settings | security |

[ PDFMaker Settings
Conversion Settings:

Use these settings to create PDF Documents suitable for compliance with 10CFR1,
Appendix A

¥ View Adobe POF result

V¥ Prompt DF file name
< I_ Convert Document Information FatsrE ERiTE o

 Application Settings
[~ Attach source file to Adobe PDF

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. All rights
r“ reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/or other countries,

Restore Defaults | oK I Cancel | Help |

Leave the configurations under the Security tab as they are. Click on .



Follow the steps below to convert a Microsoft Office Project to PDF.

Launch Microsoft Project (either on the desktop or from Start => Programs =

Microsoft Office > Microsoft Office Project 2003).

Open a Project by going to the main menu and clicking on File => Open.

[ Microsoft Project - Projecti [_[a]x]

File | Edit Wiew Insert Format Tools Project Collaborate Window Help Adobe PDF pe a question forhelp = @ X
gl mew.. Cril 1@ e ga |2 B | @ ¢ 9 = show-| s -8 -|B 7 U
-|Lj I e - Report v!
ﬁ Close
A save Cirl+5
Save As... | Duration ’_5 Apr 24,05 May 01, '05 May 08, ‘05 May 15 o |
Gy Save AsWeb Page... WIT[F[s[s[M[TW[T[F[s[SM[TIW[T[F[S[STM]T[W[T]F[s|s W1 |
Page Setup...
&, Print Preview
= print... Ctrl+p
Send To 3
Exit
¥
_IEI
‘ oI N T M
[Ready Il Bt |[cars| [nom |[sceL ([[ove |z
The Open window appears.
Open
tookin: [ 1033 |l @ -3 @ X 3 - Toos~
: fFAX. ElresconsT MPT
_J Microsoft Project Web 5| SOFTDEV.MPT
MyRecent 1] ADO3DPL MPT Eh]soFTLOC.MPT
Doauments  Wofl comconsT Mt E|sPsvanpL MPT
= 2] EnGINEER MPT B winxppep.MpT
@ 4| EXCHANGE. MPT & wsozopLMPT
Desktop | ZHOMEMOVE.MPT | wssDpL MPT
%] INFSTDEP MPT
\ | MsFaPP, MPT
2] NEweTz MPT
My Documents 2| NEWPROD. MPT
E| OFFDDRL MPT
S %] OFFMOVE.MPT
f“;g 2| PR 1030PLMPT
My Computer 8] pRoyIoFF. MPT
‘:1)1 File pame: = -
My Netwark I J L | L
Places Files of type: |M|crosoFtProJectF|Ies (*mp=) j | Cancel

Select the Microsoft Project plan you want to convert to PDF and click on

(pen

Note: Remove all hyperlinks to other electronic files or Web sites unless the

document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office Project 2003 to PDF file,

“Convert to Adobe PDF” and “Print to PDF".

5.1.5a “Convert to Adobe PDF’ method:

Note: If you are using an older version of Microsoft Office Project or Adobe Acrobat 5.0
or older, please follow the instructions on page 91, “Print to PDF”.

From the main menu, click on Adobe PDF =>Convert to Adobe PDF or click

OI”IE.

&
@ e Efit View Insert Format Tools Project Collaborate  wWindow
|

Help

Adobe PDF Type a question for help -

e

Convert to Adobe PDF

SRRl BesER @ Bis s -n

sks| -~ | Resources = | Track - | Report v!

/A i

=
=

Convert to Adobe PDF and EMail
Convert to Adobe PDF and Send for Review

Change Conversion Settings

-

|

o Task Name | Dec 28, '03 Jan 04, '04 Jan 11, '04 Jan 18, '04
S[EM[TW][T[F[s|s[M][TW[T[F[S[S[M[T[W][T[F[S|S[M][T[W[T]F
1 & = Conceptual L
2 = Planning and Control L
R Business plan identifying
4 Define project objective :
= ldentify industry standan
6 Develop preliminary conc
T Initial planning complete
8 Develop appropriation =t
9 Develop management mo
10 = Site Assessment
A1 ldentify potential sites
12 Define infrastructure reg
13 Define utility needs
14 Identify project =site
15 Asszess regulatery and e
16 Identify permitting require
. 7 Dernmmend aite _Pl . _I
[ready || [ExT [caps [wum [scrRL [ovr

s!&l;

The Save Adobe PDF File As window pops up. Enter the name you want in
i

the File Name field, then click on| e |.

Save Adobe PDF File As

Save in: |@ 1033

i 3
El O 2 =
|IFAx
|CS)Microsoft Project Web
File name I j Save I
Save as type: |PDFhles = Cancel




A series of popup windows show the conversion status.

£ Acrobat PDFMaker |

Configuring Adobe PDF Printer ... 10% complete

EENENNEE Cancel

Show Details
Printing... |
Mow printing page &
of 'ENGINEER' on the
Adobe POF on Ne02:

When the conversion is completed, the Microsoft Office Project 2003 plan is
converted to a PDF document and Adobe Acrobat Professional (or Adobe
Acrobat Reader) may launch automatically with the new PDF document.



5.1.5b

“Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.

Bl Microsoft Project - ENGTHEER.mpp

A

B
E._t'
=

i
£

Save As...

Save As Web Page...

Page Setup...

Print Preview

Cirl+M
Ctrl+0

crl45

m| = & | NoGroup

Fle | Edit Wiew Insert Format Tools Project (Collaborate MWindow Help Adobe PDF
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S[M][TW]T[F[S[S[M[TW[T[F[5

| e

Print...

Ctrl+p

Send To

1 ENGINEER. mpp

2 \Program Files\Templates', 1033\ ENGINEER. MFT

3 VProgram Files\Templates' 1033\ ENGINEER. mpp

Exit

¥

13
14
15
16
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3

|

Project

Sponsor
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| Ready
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Bt ([caps| [num [scAL [ovr| 2

The Print window pops up. Verify that Printer Name is set to Adobe PDF from
the dropdown menu.

[ Printer

MName:
Status:
Type:

Where:

Comment:

Adobe PDF

Idle
Adobe
My Documents\=.pdf

PDF Converter

Properties

~Print range

= all

" Page(s) From: I 33 To: I 33

Copies

Number of copies:

r Timescale

o Al

" Dates From:

To:

[Thuo1/ozos -
[Mer 05708108 -|

I Print left column of pages only

¥ Manual page breaks

Preview |

Close

Click on Ml to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

* Change Default Settings to NRC-10CFR1 ( the default profile you created in
Section 4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.

&> Adobe PDF Document Properties

Layout | Paper/uaity [P} Adobe PDF Settings
—&dobe PDF Corvergion Settings

Uze these settings to create POF Documents suitable for campliance with TOCFR1, &ppendiz

Q.-’-‘-.

Default Settings: [l g] - Edit... |
Adobe PDF Security: INone j Edit... |
Adobe PDF Output Folder IF'rompt for Adobe FDF filename j Browse... |

Adobe PDF Page Size: [Letter =l Add... |

[+ Wiew adobe PDF results

<l Add Document Information
< Do not zend fonts bo “Adobe PDFT_>

¥ Delete og filez for suscessful jobs

[~ 2sk to Beplace existing PDF file

ok | camcel |

Click on and the Print window reappears. Click on to start the

conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .

Save PDF File As EHE

Savein: [ 1033 | e ® ek E-

A
|3 Microsoft Project Web

File name: [ENGINEER o

Save |
Cancel

Ll L

Saveastpe:  [PDFfies ("PDF)




The Creating Adobe PDF window appears to show the conversion status.

Creating Adobe PDF M= |

Document Mame : | Microsaft Dffice Project - ENGINEER. mpp =

— POF Progress
Microgoft Office Project - EMGIMEER. mpp

FOF Mame: EMGIMEER. pdf
PDF Folder : C:h\Documentz and Settingzhbkdn’bdy Documertsh,

When the conversion is completed, the Microsoft Office Project 2003 plan is
converted to a PDF document and Adobe Acrobat Professional (or Adobe
Acrobat Reader) may launch automatically with the new PDF document.



5.1.6 m MS-Office Publisher 2003

Important: if you haven't done so, follow the instructions in Section 4.1, “Setting up
and configuring Adobe Acrobat Distiller/PDFMaker and setting preferences”, to create
an Acrobat Distiller/PDFMaker profile.

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Microsoft Publisher (either on the desktop or from Start > Programs =>
Microsoft Office = Microsoft Office Publisher 2003).

Verify that the Microsoft Publisher conversion settings are set to the profile you
created in Section 4.1 by going to the main menu and clicking on Adobe PDF =>
Change Conversion Settings.

Note: Do so once and then leave the settings alone unless you want to use other
settings. When you have configured and saved the Acrobat PDFMaker settings, start
the conversion process on page 96 of this section.

{5} Publication3 - Microsoft Publisher - Print Publication

! Fle Edit Wew Insert Format Tools Table Amrange  Window Help | Adobe FDF Type a question for help  ~
NEH SRV (% REFI--|¢- @ @ (T ConverttoAdobepoF

44' ” ” || B S U |E = A= Convert to Adobe PDF and EMail
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The Acrobat PDFMaker window pops up.
=

Settings | Seaurity | %

~PDFMaker Settings
Conversion Settings

@ Use these settings to create Adobe PDF documents best suited for high-quality =

prepress printing. Created PDF documents can be opened with Acrobat and hd

¥ view Adobe PDF result
¥ Prompt for Adobe PDF file name

¥ Convert Document Information AT ETE SRR |

—Application Settings
™ Attach source file to Adobe PDF
¥ add bookmarks to Adobe PDF
¥ Add links to Adobe PDF
¥ Freserve Spot Color in Adobe PDF
¥ Frint Crop Marks
™ allow Bleeds
I™ | Frint Bleed Marks
¥ Preserve Transparency in Adobe PDF

reserved. Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/or other countries,

' ‘ ] Copyright © 1937-2004 Adobe Systems Incorporated and its licensors. All rights

Restore Defaults 0K I Cancel Help

Under the Settings tab, in the Conversion Settings field of the PDFMaker
Settings section, click on the dropdown arrow and select the profile you have
created (e.g., “NRC-10CFR1"). Uncheck Convert Document Information.

#2 Acrobat PDFMaker x|

Settings | Security |

[~ PDFMaker Settings
Conversion Settings:

Use these settings to create PDF Documents suitable for compliance with 10CFR1,
Appendix A

[V view Adobe PDF result

¥ Prompt for Adobe POF file name [}s
C ! Convert Document Information ~> FEETEE I
— Application Settings

™ Attach source file to Adobe PDF

[ Add baokmarks to Adobe PDF

¥ Add links to Adobe PDF

¥ Preserve Spot Color in Adobe PDF

¥ Print Crop Marks

[ Allow Bleeds

I™ | Frint Bleed Marks
¥ Preserve Transparency in Adobe PDF

® Copyright © 1987-2004 Adobe Systems Incorporated and its licensors. Al rights
r“ reserved, Adobe, the Adobe logo, Acrobat, the Acrobat logo, PostScript, and
the PostScript logo are either registered trademarks or trademarks of Adobe
Adobe Systems Incorporated in the United States and/or other countries.

Restore Defaults | QK I Cancel Help |

Leave the configurations on the Security tab as they are. Click on - :



Follow the steps below to convert a Microsoft Office Publisher to PDF.

Launch Microsoft Publisher (either on the desktop or from Start > Programs =>
Microsoft Office = Microsoft Office Publisher 2003).

Open a Publisher publication by clicking on File => Open.

= Publication1 - Microsoft Publisher - Web Publication O] x|

File | Edit Wew Insert Format Tools Table Arrange Window Help  Adobe PDF Type a question for help -

A New... Cirl+N QAR e @Hies HHHE

[ [gpen-- coisa_| b= iz = = =9 £
o H i= 2 = IS | A - - A - S OEE

[ Close Ctrl+F4

il
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b
|'

Import Word Document...

1]

Save Ctrl+5

=
= Start
h.l
=]

fams Wy

Page Setup... ) To get Started,
Print... Ctrl+p select an option in the list.

Send E-Mail »

Print Preview

1 C:\Publication2.pub
2 C:AWINDOWS\ShellNew\MSPUB.PUB

¥

e Bl

p—
- |1 Blank Print Publication

5 #] Blank \Web Page

[8H] From existing publication. .. 4
=4 or- = [ ]|"h

[Z) publication2.pub
() msPUB.PUB

[ More...

il
L
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=

Bl |

The Open window appears.

‘Open Publication llil
Look in: ID My Documents j ﬁ + 3@ K Ca - Took -
y= | ) Corel User Files My Documents
"] |:iMy eBooks
My Recent @My Music
Documents ﬂﬂMy Pictures
Desktop
My Documents
My Computer
1 File name: | h O
n Open  |*
My Metwork I J
Places Files of type: I.-!II Publisher Files (*,pub;* htm;* himl; * mht; = mhtml; “dcj | Cancel

Select the Microsoft Publisher file you want to convert to PDF and click on
Open

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.



Note: There are 2 ways/methods to convert a Microsoft Office Publisher 2003 to PDF

file, “Convert to Adobe PDF” and “Print to PDF”.

5.1.6a “Convert to Adobe PDF’ method:

Note: if you are using an older version of Microsoft Office Publisher or Adobe Acrobat

5.0 or older, please follow the instructions on page 99, “Print to PDF”.

From the main menu, click on Adobe PDF =>Convert to Adobe PDF or click

on.@

: Filgf Edif view Insert Format Tools Table Arrange Window Help | Adobe PDF Type a question for help

D/ S AT % BRSO - - & - | @ e | T Convertio Adobe POR

I

M| Convert to Adobe PDF and El\l'laill’\S
ﬁ Convert to Adobe PDF and Send for Review

Change Conversion Settings
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—  |=¥ Publication Designs _E
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Title page —
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Include MNone _E
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The Save Adobe PDF File As window po
the File Name field, then click on | Sae

ps up. Enter the name you want in

Save Adobe PDF File As HE
Save in: [ < (C) Local Disk = Q-
{5 Rwisettings ([SyMyFiles
ﬁ |3 ADAMS [ChMDPs
| Archive ([CiMew Folder
I—::‘ | )Converted [CANGM
5 |data peS
Desktop |-S)Documents and Settings [CProgram Files
| )Drivers rs
| ihomes asqL
My Documents [ e U] Chtemp
= |=y1ssC Shtest
‘I | ILDClient [Cywebtrends
My Computer [ MLET] gwmnows
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-
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File name: j Save
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A series of popup windows show the conversion status.

£ Acrobat PDFMaker E |

Converting to Adobe POF ...

II. Cancel

Show Details

£ Acrobat PDFMaker E |

Configuring Adobe POF Printer ... 50% complete

ENNENNENENEN Cancel

Show Details

When the conversion is completed, the Microsoft Office Publisher 2003 is
converted to a PDF document and Adobe Acrobat Professional (or Adobe
Acrobat Reader) may launch automatically with the new PDF document.



5.1.6b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.

I} Publication2.pub - Microsoft Publisher - Print Publication

| File | Edit Wiew Insert Format JTools Table Arrange Window Help  Adobe PDF Type a question for help -
(| e CHls M- - @B T 5%
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£ Save As...

g IQ Web Page Preview
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lE & Print Preview
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The Print window pops up. Verify that the printer name is set to Adobe PDF
from the dropdown menu.

Print

Status:  Ready

Type: Adobe PDF Converter

Where: My Documents

Comment: % ™ Print to file

—Print range Copies

& al Mumber of copies: |1 3:
" Pages from: Il to: IZ

" Current page Iﬁ | Gollate

Change Page Order... I

Adyanced Print settings... | ok | canel |

Click on _fropertes | to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

* Change the Default Settings to NRC-10CFR1 (the default profile created in
Section 4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.
&% Adobe PDF Document Properties K E3

Layout | Paper/Qualty [FF Adobe PDF Settings |
—&dobe POF Conversion Settings

Uze these settings ko create POF Documents suitable for compliance with 1T0CFR1, Appendix

(;)A

Detault Settings: [NRC-10CFR1 =] Edt. |

Adobe FDF Secunty: INone j Ll
Adobe PDF Dutput Folder | Prompt for Adobe POF flename | Browse.. |
Adobe PDF Page Size: ILetter j Add.. |

v iew Adobe PDF results

Add Diocument [nformatio

Do not send fonts to “dobe PDF™

[v Delete log files for successful jobs

[~ Aszk to Beplace existing PDF file

ok | cancel |

Click on and the Print window reappears. Click on to start the

conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .

Save PDF File As HE3

Save in IBMyDncumants ﬂ - ¥ E-

|5 Corel User Files
|5iMy eBooks
@My Music
ﬂMy Pictures

.,_"-' Cisco CCNA.pdf

File nams Publication? pc =l Save |
Save as type |PDF files (~PDF) =l Cancel




The Printing window appears to show the conversion status.

Printing Eq |

Publisher is now printing page 2 of your publication:

'Publimﬁ%lwb' an the

Adobe POF on Mel3:

100%

When the conversion completed, the Microsoft Office Publisher 2003 is
converted to a PDF document and Adobe Acrobat Professional (or Adobe
Acrobat Reader) may launch automatically with the new PDF document.



5.2 Converting Corel WordPerfect Office X3 to PDF
5.21 = WordPerfect X3

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further. Instructions to remove/delete sensitive/unwanted text can be found at
http.//adamswebsearch.nrc.gov/idmws/ViewDocByAccession.asp ?AccessionNumber=ML060760605.

Launch Corel WordPerfect (either from the desktop or from Start => WordPerfect
Office X3 = WordPerfect X3).

Open a WordPerfect document by going to the main menu and clicking on File =>
Open.

[# wordPerfect X3 - Document1 [-olx]
Ele Edit View Insert Format Table Tools Window Help TS
bl @B - -8B 7 U-FP | E-1-m-| 2 - | D e |
1| 7 u - | e oy - || = |
Open an existing document into a new window |
=) | . 3 . 7 h[]
=
=
[Documene B[Ts 48 & ~o Insert Pg 1Ln 1~Pos 1- -
[ Open File - (C:) Local Disk [CIci=]
Ele Edit Wiew Tools Favorites Help
I N=aE-EE Y X
Look in: [ e (€] Local Disk -l = T
Name [ Size | Type [ Date Modified_~ [ =l
[C.Rwisettings File Folder 02(22/2005 5:39 PM
EMusic File Folder 02/24/2005 10:32 AM J
MSOCache File Folder 03(30/2005 5:34PM
ChcFold File Folder 04/01/2005 12:05FM
C3HSH File Folder 05/26/2005 2:43 PM
[ShDrivers File Folder 06/23/2005 9:44 AM
[Chjoboptions_prefight File Folder 08/09/2005 11:24 AM
(Capiskz File Folder 08/09/2005 11:36 AM
CADAMS File Folder 10/21/2005 3:18 PM
[E)wmdownloads File Folder 10/25/2005 9:07 AM
=es File Folder 12/27/2005 8:24 AM
== NTY vy il Enldor AAINAIINAE ATE TR _'I
File name: ["." =)
File type: |@ AllFiles (7] =] Last modified: [y Time 3| [Ty
FindNow | Advanced.. | Mew Search | Ciose |

Select the WordPerfect document you want to convert to PDF and click on
Open

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing. There is also a known problem with the search
function in Adobe Acrobat when using Publish to PDF function. Until further
notice, go to page 123, “Print to PDF”, to convert to PDF.



Note: There are 2 ways/methods to convert a Corel WordPerfect X3 to PDF file,
“Publish to PDF” and “Print to PDF”.

5.2.1a “Publish to PDF’ method:

On WordPerfect’'s

main menu, click on File = Publish to = PDF.
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—- Prerequisite — FileNET FirstView 2003586 Instructor-
Led (classroom)$
900
304337 Student
Guide w/CBT N/C (see NOTE)
Panagon Content Services Panageon CS System Administrator 200265 $2,25
o/
4.5
da
(mandatory prerequisite for 200631 and 200267) =
Panagon Web Publisher Administration and Support 200631 $2.00 2
0/ O
3458 2
Aa =]
Document1 FileNET Corporation Educatio... EI[Tx 4B @ < Count > | Insert | Pa1Ln0.8"Pos2.13°

The Publish To PDF window appears.

General

File name: I"-—.FileNET Corporatioh Education CoursesOCIO pdf Browse |

Export range
% Full document " Cument Pags
£ Selection " Pages: [1-2

|Objed5 I Document I Advanced I

Compatibility: | Acrobat 50 =
Author:
Keywords: |

FDF style: IStanu:Iard desktop printing and viewing d + | - I

JUSNRC

ok | Cancel | Help |




Under the General tab of the Publish To PDF window, make sure
Compatibility is set to the max, Acrobat 5.0, and change the File Name field
to whatever you want, including the full path to where you want the file saved.

If you enable the Pages option in the Export range section, you must type the
numbers for the first and last pages that you want to publish.

Under the Objects tab, make sure the settings are similar to the figure below.
Be sure Embed fonts in document is checked. Keep the default settings for
the Document and Advanced tabs. Then click on

Publish To PDF | x| |

General Objects | Document I Advanced I

[~ Text and forts [T Compress text and line art
[ Export all tesd 32 curves
[¥ Embed fonts in document — Bitmap compression
[¥ Embed baze 14 forts Compression type: [T~ |
¥ Convert TueType to Type 1 EHwality factarn [2-255]
¥ Subset fonts J IEEE
Under IE‘D E: % of charset High quality: Lo quality
— BEncoding
" ASCII 85 i Binary

| QK I Cancel Help

The Publishing to PDF window pops up to show the conversion status.

Publishing to PDF |

The PDIF file iz cumently publizhing. ..

|

When the conversion is completed, the window disappears. The document is
converted to PDF.



5.2.1b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.

[P wordPerfect X3 - C:\FileNET Corporation Education CoursesOCIO.wpd (unmodified)

El File Edit Wiew Insert Format Table Tools Window Help =151 =]
C| New b | B -0 -B 7 U-E s E-r-m-| R - 50 e
—  Mew from Project... -
[ New > Document... Sl B 7 U - e s | oo ey - - | =
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Save 1=
Save As...
Save Without Metadata...
ADAMS Add ... : : :
ADAMS Open ... FileNET Corporation Education Courses
ADAMS Checkin ...
ADAMS Cancel Checkout ... OCIO/ADD/IMT Preparation for Panagon 2000
Properties...
Signature 3 —
Document + | Personnel Development, FileMET Directional Issues Study (Confidential SOV for NRC)
Page Setup... = B e
Jéﬁ’? e e [ education courses; cost is N/C if student is enrolled in
Print Preyiew TVIEW erals are auto ically sent to a student preenrolled in another course). Cther
Publish To v |below course names as applicable
Send To 3
Exit
E oo Course Name Course No.
Cost*/Duration
—- Prerequisite — FileNET FirstView 200356 Instructor-
Led (classroom)$
900
304337 Student
Guide w/CBT NIC (see NOTE)
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0/
4.5
da
(mandatory prerequisite for 200631 and 200267) =
Panagon Web Publisher Administration and Support 200631 $2,00 —
0/ =
35 L
da =
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The Print window pops up. Verify that the printer name is set to Adobe PDF
from the dropdown menu.

Print to Adobe PDF Izl K E3
Main I ayout | Advanced |

r— Destination

Mame: Adobe POF

Properties..
Type: Adobe PDF Converter Prters..
Status:

Ready
Where: My Documents'” pdf Status
Comment: [ Print to file
 Print Range Copiss
o+ Ful document  © Selected test Number of copies: |1 =]

" Curment page {7 Dosument summang @ @ @
" Pages: = Cellare

[~ Print in reverse order

Settings: | Cument {Current settings not saved) j Edit Settings.

Print Close | Help |

Click on _ fropertes | to bring up the Adobe PDF Document Properties window.




Click on the Adobe PDF Settings tab and change the following settings:

* Change Default Settings to NRC-10CFR1 (the default profile created in Section
4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.
% Adobe PDF Document Properties EHE

Layout | Paper/Qualiy [} Adobe PDF Settings |

—Adobe PDF Caonversion Setting:
Q gse thesze zettings to create PDF Documents suitable for compliance with 10CFR1, Appendix
Default Settings: |NRC-10CFR1 - Ed. |
Adabe PDF Secuity: [None =l Ed |
Adobe FOF Output Folder IPrompt far Adobe PDF filename j Browsze. . |
Adahe PDF Page Size: [Latter 7| sl |
v Wiew Adobe FDF results
[ Do not send fonts to dobe POF':
pb\gDeIete log files for successful jobs
[T Ask to Beplace existing POF file

ok | Cancal |

Click on and the Print window reappears. Click on fit.  to start the
conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on .

Save PDF File As [z1=]
Savein: [ () My Documents [ o = e

|2 Corel User Files
|CMy eBooks
My Music
=My pictures

%% Cisco CCNA.pdf

File name: = ILI
Saveastype:  [PDFfles (~PDF) Bl ﬂl/
A

When the prompt returns, the WordPerfect document is converted to PDF
document.



5.2.2 m Presentation X3

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Corel Presentation (either from the desktop or from Start => WordPerfect
Office X3 = Presentation X3).

Open a Corel presentation by going to the main menu and clicking on File => Open.

[l Presentations X3 - SlideShow1 (unmodified) [-ol=]

ClEle Edit View Insert Format Tools Window Help S
= [ = | i = 28 =- %+ ok oEam%

—  Ngw from Project... =

» an exdsts ument into & new window W F

ﬁml. Gpen 2n eisting document o 2 new windon ,—_[shde sow =] F9 =

T dose F

[ g C
Save
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Save As... =

| P “tie ®
o Properties...
Page Setup...

: Print... _E
Internet Publisher... S
Publish To ) =S

2 SendTo Double-click to Add Title =

S I E
SHOW OM HIE G0ice | oeeeeece et =
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[SlideShowl |

The Open window appears.

Open File - (C:) Local Disk [[o]=]

File Edit ¥iew Tools Favorites Help
fF¥soxy @ OE - Re&

Look i [ < (C:) Local Disk -] |E
MName | Size | Type | Date Modified = ‘I
CmssaL File Folder 07/24/2003 9:56 A
[f]iel File Folder 07/24/2003 10:38 ¢
[ INFORMS File Folder 07/24/2003 10:47 &
ICIsqL File Folder 07/24/2003 11:46 ¢
C3185¢ File Folder 07/24/2003 2:46 PI
I Archive File Folder 08/07/2003 10:43 £ +
4| I B

File name: I d Mpen

File type: I@ All Files %) d Last madified: IAnJJ Time 'I [Dpen as copy

Find Mow | Advanced... | Mew Search | Close |

Select the Presentation document you want to convert to PDF and click on
Open

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing. There is also a known problem with the search
function in Adobe Acrobat when using Publish to PDF feature. Until further
notice, go to page 128, “Print to PDF”, to convert to PDF.



Note: There are 2 ways/methods to convert a Corel Presentation X3 to PDF file,
“Publish to PDF” and “Print to PDF”.

5.2.2a “Publish to PDF’ method:

From Presentation’s main menu, click on File => Publish to PDF.

[ Presentations X3 - SlideShow1 (unmeodified) [==l=]
ClFle Edit View Insert Format Tools Window Help SR
D e ) Y ek &% onaas%
—  New from Project... - -
[55  open... Pt B ot B 24| Joronal sideshon <] b (] G
T Close
- =
Save
—] w
Save As... =
= ®
o Properties...
Page Setup...
¢ print.. =
‘A Internet Publisher... =
B Publish the curent document as a (.pdf) file | . =
£ sendIo b oEML DonmTECieE o0 Add Title §
Show on the Go... =
(=
Double-click to Add Subtitle o]
o
&
=
&
o
=
=
jus)
=
2
E8ll-| |
[SlideShowl |

The Publish To PDF window appears.

General |Objeds | Document | Advanced |

Eile name: [P\ pdf Browse |

S " Slides

= Full gccu!'l'lem " Speakers notes

€ Curent view © Andiencenctes  Dange:
) Selection {~ Handouts 1

Compatbilty: [Acrbat 50 <]

Author: |

Keywords: |

PDF style: ICustnm ([Cument settings not saved) j ll;l

ok | cace | Hep |

Under the General tab of the Publish To PDF window, make sure
Compatibility is set to the max, Acrobat 5.0, and change the File Name field
to whatever you want, including the full path to where you want the file saved.

If you want to convert the presentation as slides, click on Slides, etc.



Under the Objects tab, make sure the settings are similar to figure below. Be
sure Embed fonts in document is checked. Keep the default settings for the
Document and Advanced tabs. Then click on .

Publish To PDF E |

General Chjects I Document I Advanced I

— Text and fonts

[T Compress text and line art
[T Export all text as curves

[V Embed fonts in document
W Embed baze 14 fonts
¥ Convert ToueType to Type 1

— Bitmap compression

Compression type: I TI

[Huality factor [2-255]

W Subset fonts

| =

Under IED E: % of charset High gualityr Lo quality
— Encoding
" ASCII 85 (¥ Binary
Ok I Cancel Help

A Publishing to PDF window pops up to show the conversion status.

Publishing to PDF | x| |

The PDF file iz currently publizhing...

|

When the conversion is completed, the window disappears. The presentation
is converted to PDF.



5.2.2b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From the main menu, click on File = Print.

[C[Fle Edit View Insert Format Teols Window Help _=la] x|
LS B |z | =88 O- i e&-d* | phEaoy
——  New from Project... -~ -
ﬁ Open... Rl e B ‘ 'ETIOr\gina\ Slide Shaw vlﬁ i
|=| Close =
Save
= v
g Save As... E
) P ti ®
o Propertes. ..
Page Setup...
< Print 2 document ——
_M Crisp =
""" Internet Publishey. .. N o
" Publish To 3 ) =4
2/ SendTo » Diouble-click to Add Title =
7 b @
Show on the Go... -
Double-tlick 1o Add Subtitle
=}
=
o
D
=)
=
|
o
2
E[-[f |
[SlideShow1 |

A Print window pops up. Verify that the printer name is set to Adobe PDF from
the dropdown menu.

Print to Adobe PDF I=l B

Main I Layout I Advanced I

r— Destination

Mame: Properties...
Type: Adobe PDF Converter Printers

Status: Ready

Where: My Documents®” pdf Status...

Comment: [ Print to file

— Print Range Copies
* Ful document " Handouts Mumber of copies: 1 il
" Cument view " Speaker notes

" Selected abjects 7 Audience notes [+ Collate
" Slides:

Number of slides per page: 1 ﬁ
Settings: | Cument (Cumrent settings not saved) j Edit Settings...
Preview | Print | Close | Help |

[~ Print in reverse order

Click on Ml to bring up the Adobe PDF Document Properties window.



Click on the Adobe PDF Settings tab and change the following settings:

* Change Default Settings to NRC-10CFR1 (the default profile created in Section
4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.

& Adobe PDF Document Properties EE

Layout | Paper/Qualty [Z} Adobe PDF Settings |
—&dobe PDF Conversion Setting:

Use these settings to create PDF Documents suitable for compliance with T0CFR1, Appendix

(;) A
Default Settings: [NRC-10CFRT - B |
Adobe PDF Security: INone j Edit,.. |
Adobe PDF Dutput Eolder IPrompt for Adobe PDF filename j Browse. .. |
Adobe PDF Page Size: [Letter =] sk |

v Wiew Adobe FDF results

Add Document [nfarmation

Da hot gend fonts to "Adobe PDF'

by
[V "Delete log files for successful jobs

[T &sk to Beplace existing POF file

ok | cancel |

Click on and the Print window reappears. Click on . to start the
conversion process.

The Save Adobe PDF File As window pops up. Enter the name you want in
the File Name field, then click on E

Save PDF File As [ 7]
Savein: [ () My Documerts | @k

|CCorel User Files
[CIMy eBooks
@My Music
uﬂl"’ly Pictures
‘f'_fcwsm CCNA.pdf

File name: ublication2.pe j Save I
Saveastype:  [PDFfies (*PDF) | Cancel |
7|

When the prompt returns, the Corel presentation is converted to PDF.



5.2.3 m Quattro Pro X3

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Corel Quattro Pro (either from the desktop or from Start => WordPerfect
Office X3 => Quattro Pro X3).

Open a Corel Quattro Pro spreadsheet by clicking on File = Open.

B Quattro Pro X3 - [P:\Notebkl.gpw (unmodified)] [—lol=]
= Edit View Insert Format Tools Window  Help IEIET
o e =0 ||~‘w1v@;s;|EthﬂEtlf@;Zv:;;::aﬁﬁalq*l-e-
Mew from Project.. Cirl+shift+n |
” i Pn a0 sring Sonument o 2 e vinden {cr_-l+o;-‘1 L R | |
— Close
IA A Close all ]
— Save crl+s 5 = = 5 ‘ 3 I I 3 I f’
— Save As... F3
El Save All
| Properties. ..
[« Notebook Group »
:
¢ Page Setup...
| Print ctrl+p
¢ Print Preview
¢ Publish to >
:“ send to >
Kl Open this document
_: Exit Alt+F4
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23 =
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wlelz» =l _~ [CE & 1.0 1 & T _F 1_& J_& 1_T |4 | 10
MNetebk.apw | & NUMEsFS SCF!L‘ READY

The Open window appears.

& open File - (C) Local Disk HE B3
File Edit View Tools Favorites Help

f e Xg|mE B E S hdd

Look in: I@ [C:] Local Disk j E
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I)Carl I Global_nudear _fuel [CTT_coordinators
ICSiCFold [SiHidden_text 153 3im_Blanton_report =
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File hame: I*.CIDW d Open
File type: ||] WP 33 (apw) v| Lestmodiied: [Ary Time -] Oren s Copy

Find Now | Advanced... | Mew Searchl Cloze |

Select the Quattro Pro spreadsheet you want to convert to PDF and click on
(Open

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing. There is also a known problem with the search
function in Adobe Acrobat when using Publish to PDF feature. Until further
notice, go to page 133, “Print to PDF”, to convert to PDF.



Note: There are 2 ways/methods to convert a Corel Quattro Pro X3 to PDF file,
“Publish to PDF” and “Print to PDF”.

5.2.3a “Publish to PDF’ method:

From Quattro Pro’s main menu, click on File = Publish to PDF.

¥ Quattro Pro X3 - [C:\nrctsads (unmeodified)] [c[e]=]
” = 5 Edit View [Insert Format Tools Window Help ;Iﬂl ﬁl
s = / az o
o e o e - mial HEEEE ARk
——  Mew from Project... Crl+shift+
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[She  Closeal |
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[  Saveds. F3
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R Properties...
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| 4  PageSetup...
1 Print cil+p
|1 Print Preview
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| 2 sendto 4 publish to XML...
—'gj 1nrets.ds wbiizh w PCF]
2. 2P:\Work\E2E3 Retreiver BD-24.x1s 4730
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The Publish To PDF window appears.

Publish To PDF (=]

General IObjec:ts I Document I Advanced I

File name: Erowse |
Export range
" Motebool " Selection I _I
" Cument Shest

Pages from: |1 ﬂ to: IE'EE ﬂ

Compatibility: |Acrobat 5.0 =

Authar: Ikdn

Keywords: I
PDF style: ICustc-m {Current settings not saved) d + | - |

oK | Cancel | Help |

Under the General tab of the Publish To PDF window, make sure
Compatibility is set to the max, Acrobat 5.0, and change the File Name field
to whatever you want, including the full path to where you want the file saved.



If you want to convert the whole notebook, click on Notebook, etc.

Under the Objects tab, make sure the settings are similar to figure below. Be
sure Embed fonts in document is checked. Keep the default settings for the
Document and Advanced tabs. Then click on .

Publish To PDF E |

General Chjects I Document I Advanced I

~ Text and fonts
[T Export all text as curves

[T Compress text and line art

[V Embed fonts in document
W Embed baze 14 fonts
¥ Convert ToueType to Type 1

— Bitmap compression

Compression type: I TI

[Huality factor [2-255]

W Subset fonts

| =

Under IED E: % of charset High gualityr Lo quality
— Encoding
" ASCII 85 (¥ Binary
Ok I Cancel Help

A Publishing to PDF window pops up to show the conversion status.

Publishing to PDF | x| |

The PDF file iz currently publizhing...

|

When the conversion is completed, the window disappears. The Quattro Pro
spreadsheet is converted to PDF.



5.2.3b “Print to PDF’ method:

Note: Remove all hyperlinks to other electronic files or Web sites unless the
document includes a disclaimer that the hyperlinks are either inoperable or are
not essential to the filing.

From Quattro Pro’s main menu, select File => Print.

[ Quattro Pro X3 - [G\nrots.uds (unmodified)] [[ol=]
”I: Edit View Insert Format  Tools Windowe Help ;Iﬁl 5'
D ew cule o oy - i A e (=] b e e A E - D e | k| @
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Print Preview
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A Spreadsheet Print window appears. Verify that the printer name is set to
Adobe PDF from the dropdown menu. Click on Notebook to convert the
whole spreadsheet.

[ spreadsheet Print =]
Prirt | Details |
Cument Printer
Name: IAcIobe PDF d Properties [ |

Copies

MNumber of copies: I'I ::II
€ Cotate
Range: from: | jl to: |39 jl & Group Iﬂ

Page Setup... | Prirt Preview... |

Print... Close Save Settings I Status | Help I

Click on _Eropertes | to bring up the Adobe PDF Document Properties window.



Under the Adobe PDF Settings tab, change the following settings:

* Change Default Settings to NRC-10CFR1 (the default profile created in Section
4.1).

* Uncheck Do not send fonts to “Adobe PDF”. Uncheck Add Document
Information.
This will ensure that the fonts are embedded and exclude document’s
Properties information.

& Adobe PDF Document Properties E

Layout | Paper/Qualty [ZF Adobe PDF Settings |
—iédobe PDF Conversion Settings

Use these settings to create PDF Documents suitable for complhiance with TOCFR1, Appendix

(;)A

Default Settings: |NRC-10CFR1 = Edit. |

Adobe PDF Segurity: [Mone = Edi.. |
Adobe FOF Output Folder IF'ru:.mpt far Adobe FDF filename LI Browsze... |

#dobe PDF Page Size: [Letter =l &dd... |

v “iew Adobe PDF results

<| Add Document [nformation >

Do not send fonts to “Adobe PDES >

¥ "Delete log files for successhul jobs

[~ &szk to Beplace existing POF file

0K I Cancel

Click on and the Print window reappears. Click on . to start the
conversion process.

A Creating Adobe PDF window pops up to show the conversion status.

Creating Adobe PDF = B
Diocurnent Mame : IE:\nrcts.xIs d
FPDF Progress

C:hhrcts. sls

POF Mame : nicte pdf
PDF Folder :  C:\Documents and Settingsikdn'by Documents',

When the conversion is completed, the window disappears. The Quattro Pro
spreadsheet is converted to PDF.



5.3 Converting TIFF to PDF

*** Please make sure all the sensitive/unwanted text or images are completely removed before
proceeding any further.

Launch Adobe Acrobat Professional (either by clicking on the icon on the desktop or
Start = Programs => Adobe Acrobat 7.0 Professional).

Convert a TIFF document to PDF by clicking on the main menu and selecting
File = Create PDF => From File or by clicking on the toolbar submenu and
selecting Create PDF => From File.

E2 Adobe Acrobat Professional M=l &3
File Edit View Document Comments Tools Advanced Window Help
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(] Send for Review... >
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Document Properties... G+
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PrintMe Internet Printing. .. Shift+Ctrl+9

[ History g
1C:\... \Notebk1.pdf
2C:\...\Presentation 1.pdf
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4 C:\temp'NRC Test DPI test 1 5-20-05.pdf
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Exit




An Open window pops up.

Open [=]
Lookin: |5 POF = O E
fAdobe logo. 6!
Office professional 2000, tif
Officalseal.of
Spread sheet. if
HFf_pdf_color. tif
off_pdf_white.tf
Wordrerfect cover.tif
My Computer
e
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NRC Network
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Settings.
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Notice the Settings button. Clicking it allows you to change your compression
and color management settings for the conversion process. Skip this step if
you followed the instructions in Section 4.1, “Setting up and configuring Adobe
Acrobat Distiller/PDFMaker and setting preferences”.

Select the TIFF image you want to convert to PDF and click on .
For a few seconds (longer if the file is large) you won’t see anything on the

screen and it might looks like the PC is hanging. When the conversion is
done, the TIFF image is converted to PDF and appears on the screen.
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6.0 Verifications and Document Testing before submission
6.1 Verify that the PDF Document is set for Fast Web View.

* Open the PDF document in Adobe Acrobat Professional.
* From the main menu, select File = Document Properties or click on the right arrow
on the vertical scroll bar and choose Document Properties.

* In the Document Properties window, under the Description tab, verify that Fast Web

View is set to Yes. See the figures below.
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6.2 Searchable Text (hidden text error)

Verify that OCR (Optical Character Recognition) has been applied correctly to the
image-only scanned pages.

» Open the PDF document in Adobe Acrobat Professional.

» Click on the Select button to use the Select function.

* Place the cursor before the first character of the page. Hold down the left mouse
button and drag downward through the page.

2 Adobe Acrobat Professional - [EIE_Submittal 2.5 2.6.pdf]
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+ If all the text is highlighted as you move the mouse cursor down over it, the images
have been OCR-ed correctly (or have “hidden text”).



If the image is not set for searchable text, only whole pages or whole areas can be
selected as in the figure below.

I8 Adobe Acrobat Professional - [FIE_Submittal_2.5_2.6.pdf]
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6.3 Embedded Fonts verification
Verify that all Fonts are embedded in the document by taking the following steps:

* Open the PDF document in Adobe Acrobat Professional.

* From the main menu, select File = Document Properties, or click on the right arrow
on the vertical scroll bar and choose Document Properties.

* On the Document Properties window under the Fonts tab, verify in the Fonts Used
in this Document section that all the fonts include (Embedded Subset) as the figures

below.
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6.4 Preflight error tests
Do a Preflight test for any errors before submitting the document to the NRC.
6.4.1 m Adobe Acrobat 6.0 Professional
* Launch Adobe Acrobat 6.0 Professional.

* From the main menu, click on Document and select Preflight.
+ Select the correct profile use for testing, i.e., NRC-10CFR1.

Adobe A bat P e a L]
File Edit View Tools Advanced Window Help
; [_% t‘b F Pages ’ 'j Review & Comment ~ IIEI Secure v Z Sign - m -

£ N

P THE seq ) o © 100% ) |1 O3 D How To.? ~

e

El Security
A Digital Signatures

Paper Capture

Preflight...

Preflight: Profiles

Sample profile

Features newer than PDF 1.2
Features newerthan PDF 1.2
Featurss newer than POF 1.4

List all images

List all objects not 4c

List all objects not 4c or spot

Ligt all overprinting objects

List all potential problems

List all transparent objects

List JPEG compressed images
Mare than 1 plate

More than 2 plates

Maore than 4 plates

Mot supported in Post Script 3

MNat supported in PostScript Level 1
Mot supported in PostScript Level 2

Output not 1007% predictable
PDF/%-1a compliant .
PDF/%-3 compliart (4c=spat} + Click on the Analyze button to start
PDF/%-3 compliant (ICC/Lab OK) .

the Preflight test.

H




When the Preflight test is finished, the Preflight: Results window appears listing the

errors.

Preflight: Results

[ Pages from "Document 1.pdf"

€9 Problems

2 Used profile: "NRC-10CFR1"
D Page - 1

’ Image res. less than 300 ppi
(- Image res. less than 300 ppi

Preflight: Results

@ Pages from "Document 1. pdf"
=@ Problems

+-[C} Pages
@ Preflight information
i@ Used profile: "NRC-10CFR1"
ERE] Page - 1}

- Image res. less than 300 ppi
-~ Image res. less than 300 ppi (Resolution =81.151483)

D Detailed information

= ] Image res. less than 300 ppi
Image res. less than 200 ppi (Resolution =120.484848)

D Detailed information

E]--- Overview
=0 P
- Preflight information

[] Activate Snap Background color: light gray 25

Hits per rule: IC
| [ vaidete.. ] ]

[ Report...
[ Activate Snap Background color: light gray 25% v
Hits per rule: |AII v |
[ Report... ] [ Validate... ]

Click on the Report icon if you want a PDF version of the results. Otherwise click on

(e



6.4.2 m Adobe Acrobat 7.0 Professional

* Launch Adobe Acrobat 7.0 Professional.

* Open a PDF document that you want to test for errors.

* From the main menu, click on Advanced and select Preflight.
+ Select the correct profile for testing, i.e., NRC-10CFR1.

8 Adobe Acrobat Professional
File Edit View Document Comments Tools | Advanced Window Help
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Security Settings...
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\Web Capture

Use Local Fonts Shift+Ctrl+¥

Qyerprint Preview Shift+Etr]+7

Output Preview...

,@ Profiles \»53 Results | ﬂ Report =¥ Comments @ Edit | Options =

Select a profile for preflighting the cument PDF:

Compliant with PDF/A (Draft) -
Digital press (B/W)

Digital press (color) |
Magazine Ads

Newspaper Ads

PDF/X-1a:2001 compliant

PDF/X-1a:2003 compliant

PDF/X-3:2002 compliant

PDF/X-3:2003 compliant _ * Click on the Execute button to start
<t fod rffeot (CUMYK and cont L 31 .
Pumose of the selected Prefight profle: checking the document for errors.
=
I
I~ | Freflight only pages |1— ko |1—
Execute |
PDF/X status of curent documet: S~——

ﬁ| Mot a PDF/X file.




Below is an example of an output error. The document has poor-quality images and does
not meet the 300dpi requirement specified in the E-Rule.

Preflight

Profiles Q& Results | @ Report ,_@ Comments (& Edit | Optionz

x Preflight check "NRC-10CFR1" found the following emors:

H Al pages from "Cizco CCNA pdf”

-

x Continuous tone image resolution lower than specified (5 matches on 2 pages)
x PDF version is newerthan 1.3

L Overview

Preflight information

Profiles & Results | @ Report _=Fl;|' Comments (& Edit | Options =
[ Show detaled fommation abodt docamert x Preflight check "NRC-10CFR1" found the following emors:
[~ Show selected page element in Snap view

H All pages from "Cisco CCNA pdf”

Elx Continuous tone image resolution lower than specified (5 matches on 2 pages)]
[ & | Summary

s

Page 1: Colorimage 195.2x250.74 pt 218.245 ppi RGB {ICC) overprint: off
@ Page 5: Colorimage 464.1x19.68 pt 52 463/98.781 ppi RGE {ICC) overprir
Page 5: Colorimage 215.280.72 pt 52.308/100.0 ppi RGE (ICC) overprint
Page 5: Colorimage 464 1x250.8 pt 92 483 ppi RGE {ICC) overprint: off
Page 5: Colorimage 10.92x0.72 pt 52.308/100.0 ppi RGE {ICC) overprint:
x PDF version is newer than 1.3

-4, Overview

- §B) Preflight infarmation

¥ Show detailed information about document
[~ Show selected page element in Snap view

Expanded version

Click on the Report tab if you want a PDF version of the results, or click on X to exit.



6.4.3 m Adobe Acrobat 8.0 Professional

Launch Adobe Acrobat 8.0 Professional.

* Open a PDF document that you want to test for errors.

* From the main menu, click on Advanced and select Preflight.

» Select the correct profile for testing, i.e., NRC-10CFR1, under Custom profiles

Adobe Acrobat Professional [=[o)x]
File Edit View Document Comments Forms Tools | Advanced Window Help
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I Find -
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Document Processing
Web Capture
Accessibility

EDF Onfimizer
=7 prefight. ..

Compare Documents...

,@Proﬁles '\&Results | Zj Report Y Comments f Edit| Options ~
Preflight profiles: £|

[#-Acrobat/PDF version compatibility
I?"Custnm profiles
P NRC-10CFR 1
*-Digital printing
"'PDF analysis

[-PDF fixups

'"PDF,-'ﬂ compliance
"'PDF,-‘)( compliance
"'Preprﬁts

* Click on the Execute button to start
= checking the document for errors.

Purpose of the selected Preflight profile:

™| un Preflight checks Far wisible layers anfy.
I R Preflight profile withaut applying Fiups

I~ Preflight only pages I 1 to I 5 Execute |
~—

ﬁ Mot a PDF/X file.
ﬁ Mot a PDF/A file.




Below is an example of an output error. The document has poor-quality images with
resolution less than 300dpi requirement specified in the E-Rule.

Preflight <]

Proﬁles q&Flesults| @ Report _ﬁ_@ Comments ﬁ Edit| Options ~

x Preflight profile "MRC-10CFR 1" found the following errors and warnings: i |
"_ﬂ Pages 1- 1019 from "006_M-663-000174, pdf” P profiles | ¥ Results | [ report =Y comments Edit| Options ~

> dp =colution of color and gray scale images is lower than 300 pixels per inch x Preflight profile "MRC-10CFR 1" found the following errors and warnings: i |
x Font not embedded (21334 matches on 1015 pages)
Page size or arientation is different from page to page E Pages 1- 1012 from "006_M-663-00017A.pdF =

=98 Resolution of color and gray scale images is lower than 300 pixels per inch (167¢
T3 summary

@ Page 45: Color image 277.5x59.25 pt 128.173 ppi RGE overprint: off

@ Page 45: Color image 103,5x25.,5 pt 96.0 ppi RGE overprint: off

Page 45: Color image 119.25%30.0 pt 96.0 ppi RGB overprint: off

@ Page 50: Color image 359.25x184.5 pt 56.0 ppi RGE overprint: off

Pag

y Page 54: Color image 277.5x59.25 pt 128.173 ppi RGE overprint: off
Page 54: Color image 103.5x25.5 pt 96.0 ppi RGE overprint: off
@ Page 54: Color image 119.25x30.0 pt 95.0 ppi RGE overprint: off
Page 61: Color image 420.0x552. 75 pt 96.0 ppi RGE overprint: off

/ @ Page 62: Color image 407.25x552.0 pt 96.0 ppi RGE overprint: off
/ @ Page 63: Color image 277.5%59.25 pt 128,173 ppi RGE overprint: off

Explanation of the selected result:

Continuous tone image resolution lower than spedfied

Page 63: Color image 103.5x25.5 pt 96.0 ppi RGE overprint: off
Page 63: Color image 119.25%30.0 pt 96.0 ppi RGB averprint: off =

Explanation of the selected result:
Continuous tone image resolution lower than spedified

L

[ show detailed information about document
I~ Show selected page object in Snap view =l
[~ Show detailed information about document

[~ Show selected page object in Snap view

H 006_M-663-00017A.pdf - Adobe Acrobat Professional Expanded version
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FIGURE 1
Relationship of Slab Thickness and Type of Aggregate

Click on the Report tab if you want a PDF version of the results, or click on X to exit.



7.0 Miscellaneous

7.1 FAQ

1.

“I received email notification from NRC support staff telling me my recent
EIE submittal was rejected because it was not set for Fast Web View.
How do | fix that?”

Follow the instructions in Section 4.1, “Setting up and configuring

Adobe Acrobat Distiller/PDFMaker and setting preferences”, and make

sure the Optimize for fast web view option is checked under the

General tab. Then recreate the PDF document. If you don’t want to

recreate the PDF document, take the following steps if you're using

Adobe 6.0 or 7.0.

* Open Adobe Acrobat Professional.

* From the main menu, select Advanced and click on Batch Processing.

* In the Batch Sequences window, select Fast Web View and click on Edit
Sequence.

* In the Edit Batch Sequence window, click on the Output Options button and
then click on the Fast Web View option to enable the feature.

* Click on the OK button to get back to the Batch Sequences window. With
Fast Web View option selected, click on the Run Sequence option.

* You are prompted to choose a PDF document to process.

* Go to the main menu and click on File/Document Properties and verify that
Fast Web View is set to Yes.

If you're using Adobe 8.0:
Open Adobe Acrobat Professional.

* From the main menu, select Advanced, select Document Processing and
click on Batch Processing.

* In the Batch Sequences window, select Fast Web View and click on Edit
Sequence.

* In the Edit Batch Sequence window, click on the Output Options button and
then click on the Fast Web View option to enable the feature.

* Click on the OK button to get back to the Batch Sequences window. With
Fast Web View option selected, click on the Run Sequence option.

* You are prompted to choose a PDF document to process.

* Go to the main menu and click on File/Document Properties and verify that
Fast Web View is set to Yes.

Take the following steps if you’re using Adobe 5.

* Open Adobe Acrobat.

* From the main menu, select File and click on Batch Processing.

» Select Fast Web View, then click on the OK button to bring up the Select Files
to Process window.

* You are prompted to choose a PDF document to process.

¢ Go to the main menu and click on File/Document Properties/Summary and
verify that Fast Web View is set to Yes.

Or simply select File © SaveAs from the top menu will also enable Fast Web View



“I'm using MS-Word, | followed your instructions in Section 4.1 to embed all fonts,
Why am [ still getting rejection messages saying that fonts are not embedded in my
document when | use File/Print/Adobe PDF?”

If you use the Print to Adobe PDF feature, follow the instructions in
Section 5.1, “Convert MS-Word document to PDF”. Remember to
uncheck Do not send fonts to “Adobe PDF” in the Adobe PDF
Document Properties.

“Why can’t | submit my document using the General EIE form. The Submit
Signed Documents to NRC button is greyed out?”

You must first click on Secure Transmission Authorization (a
required field). This will enable the Submit Signed Documents to
NRC button so you can submit your document

“I just scanned several images and converted into PDF. | have no way of checking
that the images meet the 300dpi requirement. Any suggestions?”

You can run a resolution test yourself by using Preflight (bundled with
Adobe Acrobat 6/7/8 Professional ONLY). If you're puzzled or if this is
your first time trying to convert images to PDF, send a several-page
PDF document to our technical support staff at kdn@nrc.gov. We will
tell you by email whether the document meets the 300dpi requirement.

“Your guide has no information about scanners and the preferred method of
scanning. Will you be adding instructions to support scanning?”

No. There are too many different scanners with proprietary software.
Submitters may use any scanners and scanning software with the
resolution set to scan no less than 300dpi.

“I'm having a problem converting a Microsoft Excel spreadsheet. What should |
do?”

If you can’t convert the Microsoft Excel spreadsheet using the
procedure in Section 5.1.3, “Converting Microsoft Office Suite XP/2003
to PDF—-MS-Excel spreadsheet”, use one of the following acceptable
formats to submit the spreadsheet data.

File Format Verzion Filemame Preferred Uze
Extensio
n
Microsoft® Excel® Current or 2 il Spreadsheet calculations
Drevious
Corel® QuattroPro Current or 2 wi3 Spreadshest calcwulstions
previous

The NRC may also need spreadsheet data to perform additional
calculations or analyses.



When submitting an electronic file using one of the acceptable formats,
do not change the default three-character extension for the file (for
example, a document prepared as “license_amendment.pdf” should be
submitted with the .pdf file extension and a document prepared as a
Microsoft Excel spreadsheet should be submitted with the .xIs file
extension).

“Where can | download a pre-configured Adobe Distiller PDF Settings (profile)?
And how do | install or remove it?”

You can download a Adobe Distiller PDF Settings (profile) for your
version of Adobe at http://www.nrc.gov/site-help/e-submittals.html and
place it in C:\Program Files\Adobe\Acrobat <x.0>\Distill\Settings.

To install or remove the profile in Adobe Acrobat Distiller 5.0:

* Place the downloaded profile into the Settings folder (e.g. C:\Program
Files\Adobe\Acrobat 5.0\DistilinSettings). Delete the profile from this location if
you want to remove it.

For Adobe Acrobat Distiller 6.0, 7.0 & 8.0 Professional, follow these

steps to add a new profile.

* Launch Acrobat Distiller (either from Start/Program/Acrobat Distiller
6.0/7.0/8.0 or select Advanced/Acrobat Distiller from Adobe Acrobat
6.0/7.0/8.0 Professional).

* The Acrobat Distiller window pops up. From the main menu, click on Settings
and select Add Adobe PDF Settings.

* An Add Adobe PDF Settings window pops up. Select the new profile you have
downloaded (e.g. NRC-10CFR1.joboptions) and click on Open.

* The Acrobat Distiller window reappears with the newly loaded profile as the
Default Settings.

Follow these steps to remove the profile from Adobe Acrobat Distiller

6.0, 7.0 & 8.0 Professional.

» Launch Acrobat Distiller, click on Settings and select Remove Adobe PDF
Settings.

* A Remove Adobe PDF Settings window pops up. Select the profile you want
to delete and click on Remove button.

* Click on the X button and you will be directed back to the Acrobat Distiller
window with the profile removed.

“Do you have a pre-configured Adobe Preflight profile? If so, where can | download
it and how do [ install it?”

You can download a pre-configured Adobe Preflight profile for your
version of Adobe at http://www.nrc.gov/site-help/e-submittals.html and
place it in C:\Program Files\Adobe\Acrobat <x.0>\Distill\Settings.

For Adobe Acrobat 6.0 Professional, follow these steps to install the profile.
* Launch Acrobat 6.0 Professional, and select Document/Preflight.


http://www.nrc.gov/site-help/e-submittals.html
http://www.nrc.gov/site-help/e-submittals.html

* Preflight: Profile window pops up. Select any profile and click on Edit...

« Click on the 5" button (Import) under the Profiles section of the Preflight: Edit
profiles window.

» Search for the downloaded Preflight profile (e.g. NRC-10CFR1_6.kfp) from the
Import profile from package window. Click on Open. Then click OK to get
back to Preflight: Profile window.

« Verify that the profile is on the list of pre-configured profiles.

Follow these steps to install Preflight profile for Adobe Acrobat 7.0 Professional.

* Launch Acrobat 7.0 Professional, and select Advanced/Preflight.

* From the Preflight’'s main menu, click on Options and select Import Preflight
Profile....

+ Browse and select the downloaded Preflight profile (e.g. NRC-10CFR1_7.kfp),

then click on Open.
«  Verify that the profile is on the list of pre-configured profiles.

Follow these steps to install Preflight profile for Adobe Acrobat 8.0 Professional.

* Launch Acrobat 8.0 Professional, and select Advanced/Preflight.

* From the Preflight’'s main menu, click on Options and select Import Preflight
Profile....

* Browse and select the downloaded Preflight profile (e.g. NRC-10CFR1_8.kfp),

then click on Open.
« The imported profile will be listed under the Imported profiles section.

9. “Is JPEG compression an acceptable alternative to ZIP compression?”
+ At this time JPEG compression is an unacceptable alternative to ZIP
compression. The problem is that JPEG2000 is only supported in Adobe 6 & 7.
The rule states we will support 2 versions back. Those using Adobe 5 will not
be able to display JPEG compression properly.

10. “I'm having problems viewing documents from your web site on a Macintosh....”

*  Currently our documents are compatible with Macintosh. Adobe 4.0 & 5.0 is
compatible with the MAC OS 9.x. If your Adobe 5.0 or Adobe 6.0 isn’t
functioning on MAC OS X or below, you can download a freeware PDF Browser
Plugin at http://www.schubert-it.com/pluginpdf/. Also Adobe 7 will install a
Safari plugin that enables viewing PDF files directly in the Safari web browser
window. If the MAC OS is upgraded to MAC OS X Tiger, the latest Safari RSS,
enables PDF viewing with no other application required.

7.2 Quick links

http://www.nrc.gov - U.S. Nuclear Regulatory Commission home page.

http://www.nrc.gov/site-help/e-submittals.html - Electronic Submittals homepage.

http://www.nrc.gov/site-help/e-submittals/guid-elec-submission.pdf - Guidance for
Electronic Submissions to the Commission.

http://www.nrc.gov/about-nrc/regulatory/adjudicatory/ehd/ml041560341.pdf - Guidance
for Submission of Electronic Docket Materials under 10 CFR Part 2, Subpart J.

http://www.nrc.gov/site-help/e-submittals/10cfr1.pdf - Electronic Maintenance and
Submission of Information”, also known as the “E-Rule”.




